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1. Preface

This set of documents provide you with information required to successfully use MarathonITE

in your testing projects.

The Getting Started section provides the essential information required for quickly start using

MarathonITE. We explain installation, creating test projects and recording and running the test

scripts.

We follow up with the User Guide which provides in-depth discussion about MarathonITE

features and how to use them.

The other parts of the documentation discusses and explains advanced features of

MarathonITE.

1.1. About MarathonITE



MarathonITE is a professional tool for creating automated test suites for Java/Swing™,

Java/FX™ and Web Applications through the front-end. MarathonITE supports automated

tests, semi automated tests and also an exploratory test mode for manual tests.

Like with any automation project, test automation also involves programming albeit to a

lesser extent. You find major success in your test automation project if the project is

considered as a so!ware development project and plan it accordingly. Depending on the size

of an organization and project structure, di"erent teams might be involved in creating

automated tests. We do not assume that a user of MarathonITE is knowledgeable in

programming and thus try to provide as much details as required for using Marathon

e"ectively.

1.2. Supported Platforms

MarathonITE can be used to create test suites for various platforms. At this time, MarathonITE

supports applications developed using Java/Swing™, Java/FX™ and Web technologies. The

following sections explain the support of MarathonITE for each of the platforms in detail.

1.2.1. Java/Swing™

You can use MarathonITE to test applications developed using Java/Swing™ technology. Most

standard controls of Java/Swing™ are supported by MarathonITE.

1. Supported Java Versions: Oracle Java 1.6+

2. Supported Controls:

JColorChooser

JComboBox

JEditorPane

JFileChooser



JList

JMenuItem

JProgressBar

JSlider

JSlider

JSpinner

JSplitPane

JTabbedPane

JTableHeader

JTable

JTextComponent – includes JTextField, JTextArea etc.

JToggleButton

JTree

Any custom controls that are created deriving from any of the standard controls should also

work well with MarathonITE. In those cases, where support for a custom control was not

satisfactory, you can extend MarathonITE using MarathonExtension mechanism.

1.2.2. Java/FX™

MarathonITE supports testing applications developed using Java/FX™ technologies. Most of

the standard controls of Java/FX are supported by MarathonITE.

Supported Java Versions: Java 1.8+ (Java/FX 2.2+)

Supported Controls:

JavaFXCheckBox

JavaFXChoiceBox

JavaFXColorPicker

JavaFXComboBox

JavaFXDatePicker

JavaFXDirectoryChooser

JavaFXFileChooser



JavaFXHTMLEditor.java

JavaFXListView

JavaFXMenuBar

JavaFXProgressBar

JavaFXSlider

JavaFXSpinner

JavaFXSplitPane

JavaFXTabPane

JavaFXTableView

JavaFXTextInputControl

JavaFXToggleButton

JavaFXTreeTableView

JavaFXTreeView

Any custom controls that are created deriving from any of the standard controls should also

work well with MarathonITE. In those cases, where support for a custom control was not

satisfactory, you can extend MarathonITE using MarathonExtension mechanism.

1.2.3. Web Applications

You can use MarathonITE to create automated test scripts for Web applications. Due to the

di"erences in implementation of JavaScript engine in various browsers, MarathonITE supports

recording and playing on some browsers.

Supported browsers for Recording: Chrome, Firefox, Microso! Edge

Supported browsers for Playing: Chrome, Firefox, Microso! Edge, Opera, IE and Safari

MarathonITE supports all input tag elements. You can extend MarathonITE to support other JS

libraries like JQuery, GWT etc. by extending using custom JavaScript and Ruby code.



1.3. What's New in MarathonITE 5.0

MarathonITE 5.x is our latest o"ering. If you are familiar with earlier versions of MarathonITE,

here is a list of functionalities that are supported by MarathonITE 5.0.

1. MarathonITE user interface has been rewritten to use Java/FX™. When compared to the

earlier Swing based UI, current MarathonITE UI is refreshingly modern.

2. MarathonITE supports testing Java/Swing™, Java/FX™ and Web applications.

3. Various means of grouping of test scripts is available with MarathonITE. You can group your

tests into Features, Stories and Suites.

4. MarathonITE allows you to link your test scripts with your issue manager systems (like

BugZilla, Jira) or test management system (like TestLink).

5. MarathonITE uses Allure reporting engine. Using this generates beutiful and functional test

reports.

1.4. System Requirements

For using MarathonITE you require a recent version of Java – as of this writing the latest

version is 1.8.0_121.

Recommended System Requirements

Any 64 bit system with Java 1.8+

Intel Core i5 or Intel Core i7 (the 3rd generation).

6 GB of RAM or more.

2GB diskspace required for MarathonITE installation and extra space for AUT and test

scripts.

1280 x 1024 or higher display resolution.

Mouse or other pointing device.

Minimal System Requirements

Any 32/64 bit system with Java 1.8+

Intel Core 2 Duo or higher.



2 GB of RAM or more.

2GB diskspace required for MarathonITE installation and extra space for AUT and test

scripts.

1280 x 1024 or higher display resolution.

Mouse or other pointing device.

1.5. Copyright Notice

Applies to all versions of MarathonITE

MarathonITE, as described in this documentation, is licensed under the so!ware license

agreement distributed with the product. The so!ware may be used or copied only in

accordance with the terms of its license.

© 2017 Jalian Systems Pvt. Ltd. All rights reserved.

No part of this documentation can be reproduced, stored in any retrieval system, copied or

modified, transmitted in any form or by any means electronic or mechanical, including

photocopying and recording for purposes others than purchaser’s use. Trademarks, service

marks and trade names mentioned in this documentation or elsewhere in the MarathonITE

so!ware are the property of their respective owners.

MarathonITE includes third-party open source so!ware modules that are subject to their

respective licenses. A list of third-party open source so!ware is available in product’s About

menu item.

2. Getting Started with MarathonITE



This section will guide you through creating a simple MarathonITE project. You will learn how

to record tests, running the tests, adding assertions and analyzing the results. We will also

discuss the test script structure.

This section covers general overview of test automation and MarathonITE concepts and also

has individual modules for each of the platform supported by MarathonITE.

In this section:

Introduction to Test Automation – a general introduction of test automation in the context of

MarathonITE and di"erent types of tests supported by MarathonITE.

MarathonITE User Interface – A overview of the main MarathonITE user interface.

Your First Project – Individual modules for each of the supported platforms.

2.1. Introduction to Test Automation

Industry surveys suggest that over 75% of all functional testing is still done Manually. In order

to optimise testing, it is important that we understand the applications and limitations of

Automated testing. Read on for an overview of what Test Automation is, why and when should

you use it and what advantages it can give you.

The beginning

When Test Automation made its debut some two decades ago, the IT industry heaved a great

sigh of relief. The advent of client/server architecture had introduced so many more layers of

so!ware complexity, and all of it needed testing! A lot of Tools dominated the test automation

landscape. They came in colourful packaging with a promise to bid all testing problems a

cheerful adieu!

The end?



However, automation users quickly realised that there were many loopholes to using these

new tools. For starters, every time the application-under-test changed, the automated tests

had to change as well. While the tool developers added features over time to help reduce the

testers e"orts, users began to feel that the time taken for automation development and

upkeep, far outweighed any benefits derived from it.

A new beginning

Over the years, however, automation tools have been improved with additions of new

techniques and better understanding of what testers are looking for. Tools like MarathonITE do

not hide the working behind no-code facade. Most tools generate either keyword based tests

or script based tests. With the realization that there is no code-free automation, the

automation field opened up. With the ever increasing complexities of applications, automated

tests have become a necessity and an useful weapon in tester’s arsenal.

Lets learn a little about Test Automation.

Why Test Automation?

Removing human error. Computers are good at mundane/repeated tasks, while humans

are prone to error while carrying out such tasks. Thus, test automation allows you to let

computers do what theyre good at, while freeing up the teams time to do tasks that are

more important.

For faster and accurate test execution. When we compare the speed and accuracy of



running tests, computers are far superior to their human counterparts.

Continuous Integration and continuous delivery. Test automation is more important now

than ever! With current development practises such as Agile, DevOps, Continuos

Integration and Delivery, we require tests that can run quickly and reliably – you can’t be

successful in any of these development methods without some degree of test automation.

When should you start to consider Automation?

The best time to start automation, is at the very beginning of the testing process.

Start where you are. Use what you have. Do what you can.

During your application testing process, the more steps that are not automated, the more

steps will you have to add to automation later – thus, more work! The best decision is, to

automate the testing process from the very beginning. As your application grows, the

automated tests will also grow.

What should not be Automated?

One o! items. There are exceptions of course. If a simple test can save time and energy,

then go ahead!

Tests that require manual steps. However, have a look at MarathonITE‘s semi automated

tests to simplify these tests.



Non deterministic tests. Scenarios whose behaviour can’t be predicted, should not be

automated. Its impossible to automate something when, you do not know what the output

is going to be.

Look and feel. It is subjective and need manual intervention.

What should you Automate?

Deciding what to automate is a gruelling task. The following points should help you in

deciding what you can automate:

Smoke Tests. The smoke tests provide you a go/no-go decision for further e"ort in testing.

Scenarios or User Stories. Creating tests for scenarios help you to check the functionality in

your application.

Buggy Modules. Bugs tend to group together in modules. If you find a particular module to

be buggy, put in e"ort to have automate tests around that module.

Critical and Risky portions. One area that you mustn’t forget during automation is to create

tests for the most critical and risky portions of your Application.

Test Automation Pitfalls and How to Overcome them

Forgetting that test automation is a so"ware development project. Like any computer

based automation e"ort, test automation also is a so!ware development project. Consider

it as one, plan it as one.

Concentrating and creating tests for easily verifiable scenarios. Easily verified tests, things

that can be easily verified as a human, need not be converted to an automated test.

Not having tests that are reliable. A test should identify whether a specific functional unit

is working or not.

Not having checkpoints in the tests. A functional test should ensure that result that you

expect is what you get if it is successful.

Not having similar setup as your production system. Ensure that the system setup that

you use the same (or atleast similar) to what your end users use. If your end users use

Windows™ and you test on Mac OS™, how much ever fun it is, is not going to help your

project.

Finally, Make sure that the Application development goes hand in hand with the testing, or

else, important test results may go to waste!



Some pointers to keep in mind:

Automation should not be the only type of testing. The best practise is to mix it up;

manual, semi- automated and completely automated testing.

Automation can generate fake secure feeling. If all your tests run smoothly, it may mean

that they are not doing what they’re meant – catch errors.

What advantage does Automated testing give you?

Test E!iciency

Test automation makes the testing process superbly e"icient. While your automated

so!ware completes the repetitive, time consuming, mundane tests, the testing team can

pay attention to more important and non- deterministic tasks. Thus saving time, resources

and money!

Durability

Test Automation allows you to reuse written tests. This saves time and energy while the

previously written tests can be modified to fit the ever-growing so!ware. This makes

Automation so!ware long-lasting, reusable and completely worth it!

Coverage

Test Automation allows you to cover a larger area for testing as compared to manual

testing, thus it can save time. In the long run, maintenance also reduces as a wider area is

tested by automated testing.

Consistency



Once the automation testing so!ware is set up for your Application, it acts as a consistent

platform for your testing needs. By simply running pre-recorded instructions, the regression

tests can verify if the new versions of the so!ware are compatible with pre-existing

functionalities or not. This novel consistency provides a much needed reliability for your

testing protocols.

2.1.1. Unattended Testing

When we talk about test automation, usually we refer to unattended testing. However, test

automation tools like MarathonITE can also be used to reduce the e"ort required for executing

other types of testing – semi automated or manual/exploratory tests.

You get the best results from a test automation e"ort when you can run your test suites

unattended. You can achieve this by integrating test automation with external systems like

your source control system or a continuous integration server.

Planning for Unattended Testing

Identify a Trigger Point

When do you want the test suites to be executed? The simplest solution may be to trigger a

test run at some specific time every day. Another way is to schedule a test run whenever

developers update your source control system. If you go this way, you may want to schedule

the run only when a specific action is taken – like a feature complete option of git-flow. You

may also use a CI server and use its functionality to schedule the test run.

Nothing in the above precludes you from using multiple strategies together. You can schedule

a test run every day at 2AM as well as whenever a module is updated in the code repository.

You can be creative and flexible in identifying the trigger points.

Remove Interdependencies

If your test scripts are interdependent, then you will be forced to run the tests in a particular

sequence. Besides being a bad practice, this will preclude you from executing the tests in

parallel for reducing the .



Most interdependent test scripts can be made independent of each other using Fixtures to

setup a known environment for each of the test scripts.

Dedicated Resources

Run your tests on dedicated machines to avoid disruptions by other users.

Easily accessible reports

Ensure that the test results are available in a central repository accessible to all the stake

holders. It is a good practice to send a message to all the team members with the test result –

specifically if they are errors.

Setup a Process to fix the issues

If you do not work and fix the issues raised by the test execution as soon as possible – the

failures rolls over. Over a period of time the failures overwhelm your team and the reports gets

ignored. Ensure that you have a process in place for working on the test failures.

One of the teams I worked on used to give it the highest priority. Any failures identified by the

CI Server used to be worked on and any other work is kept pending till all the failures are

resolved.

2.1.2. Semi Automated Testing

When we automate tests, we o!en find that there are cases that require manual intervention

to decide the success/failure of a test case. There is still a place for manual testing with tool

assistance in our projects. Semi automated tests falls in between the fully-automated tests and

manual tests. We use the tool to perform operations that can be automated, leaving the some

of the verification process to the manual tester.

Test Cases that can be semi automated

Look and Feel

We o!en need to check the look and feel of an application. We can use automation to

ensure that we reach each of the application windows and perform actual verification



manually.

Checking for Organizational Standards

Similar to the Look and Feel tests, we may want to check whether the UI is following our

organizational standards. In MarathonITE we can create a checklist listing our standard and

then use semi automated tests to insert the checklist to create our report.

Non deterministic output

When the output from our test case is non-deterministic, it is almost impossible to create a

automated test. Semi automatic tests can be used in these cases.

Avoid these cases

Synchronizing between two applications

There are cases where our test depends on the output from another application. It is still

better to automate the whole test (though di"icult), than keeping it semi automated.

Processing output from the application

In cases you need to operate on the output of the AUT to decide the status of a test script, it

is better to automate the test.

2.1.3. Exploratory Testing

Discovery. Investigation. Learning. These are the three main aspects that Exploratory Testing

emphasises. The most prominent characteristic is that the Test Cases are not created in

advance; testers check the system on the fly. The focus of exploratory testing is more on

testing as a “thinking” activity. During testing, the tester learns about the so!ware, its use, its

strengths and its weaknesses.

Exploratory testing was defined as “a style of so!ware testing that emphasises

the personal freedom and responsibility of the individual tester to continually

optimise the quality of his/her work by treating test-related learning, test design,

test execution, and test result interpretation as mutually supportive activities

that run in parallel throughout the project.” by Cam Kaner, who coined the term

back in 1984.



There are no hard and fast rules regarding the steps in which Exploratory Testing is done. In

general, most of them have the following features:

Step 1: Create a Test Charter

Exploratory Testing does not mean no documentation. Make a list of the following basics:

Scope and Approach: High-level description of the system, components and functionality

that need to be tested.

Expected results

Method for recording tested cases and results

Step 2: Set a Time-frame

A deadline to work within will help the tester focus.

Step 3: Log as you execute

Log test cases and results as you test. Logging creates audit and reference for your e"orts.

This can be helpful when you want to go back and review individual scenarios.



What should your Output be?

List of test cases and outcomes – including screen capture or videos of each test case

A report with key findings and recommendations.

There are several advantages to Exploratory Testing:

Faster discovery of major bugs

Decreased lead time for beginning testing

Most importantly, testing normally untested parts of the system, and therefore discovering

hidden bugs that can cause a lot of heartburn.

This testing is useful when requirement documents are not available or partially available

It involves Investigation process which helps find more bugs than normal testing

Uncover bugs which are normally ignored by other testing techniques

Helps to expand the imagination of testers by executing more test cases which finally

improves productivity as well

This testing covers all the types of testing and it covers various scenarios and cases

2.2. MarathonITE Projects

In MarathonITE you start testing by creating a project. A MarathonITE project is a folder in the

file system. Various sub folders in the project folder holds di"ernt types of project resources.



Marathonite Navigator Window

A brief description of project resources

Checklists

MarathonITE supports checklists that can be inserted into the test scripts for semi automated

tests and exploratory testing. This folder maintains checklists that you create.

Features and Stories

If you use BDD style grouping of tests, these folders keep the story and feature groupings.

Fixtures

MarathonITE fixtures allows you to prepare a well known state for each test script. You can also

use a fixture to change the launch parameters for the AUT – or launch a di"erent application all

together.

Modules

The Modules folder(s) keep method definitions that can be reused within test scripts. Unlike

the library methods available with ruby runtome, the Module methods are available for



insertion while recording. You can organize module files in subfolders.

TestCases

All test tests that you create are stored within the folder structure of TestCases folder. You can

organize the tests within subfolders.

omap Folder, omap.yaml and omap-configuration.yaml

The omap-configuration.yaml maintains the current object map configuration. The omap

folder and omap.yaml file maintains the object map being used by the project.

TestData

This folder is used for saving the test data in CSV format for data driven testing.

TestReports

When you use TestRunner view or enable generate reports options, the generated reports are

stored in this folder. Note that actual report is created only when you view the option as it is a

costly operation.

Issues

If you link your tests to an Issue manager, the tests groping is stored in this folder.

logging.properties

The logging.properties file contains the logging configuration. The default log level is warning,

however you can change it to other values while debugging MarathonITE internals.

project.json

The project configuration is stored in project.json file.

console.log.*

When test scripts are executed, the generated console output is stored in a console.log file for

the current session. Upto five files are generated and rotated for each MarathonITE session.

2.3. Your First Project



The first step in using MarathonITE is to create a test project project. This tutorial shows you

how you can create a project, record tests, run them and collect results. MarathonITE testcases

use Ruby – you can see how tests look like.

The tutorial covers di"erent application frameworks supported by MarathonITE:

Java/Swing™ Applications

Applications developed using Java/Swing™ technology.

Java/FX™ Applications

Applications developed using Java/FX™
Web Applications

Applications developed using Web technologies and used through browsers.

2.3.1. Java/Swing™ Test Project

A typical Java/Swing™ application is a set of class files bundled together in one or more Java

Archives (jar) files. In all these classes, there is a special class that has a main method that is

the entry point into the application. Once you know the main class and have the list of JAR

files, the application is launched as follows:

As this is a cumbersome way of launching an application, Java provides a set of tools to ease

the deployment of the applications.

Java Webstart™
Java Web Start is a framework developed by Sun Microsystems (now Oracle) that allows

users to start application so!ware for the Java Platform directly from the Internet using a

web browser. The launch information of the application is provided in a JNLP file. The file

along with the application JAR files are stored in an accessible location for the user. The

user needs to download the JNLP file and use javaws tool to launch the application. Java

web start is also integrated into most desktop operating systems. So opening a JNLP file

automatically launches the application.

Executables and Batch files

1  java -cp <list-of-jar-files> <main-class-name> <application-arguments>



Java applications are also typically wrapped as exeutable files or batch files. When the user

runs this file, the arguments and the environment is processed and a properly constructed

java command line is executed.

Applets

Some java applications are deployed as applets. The applets are executed within a browser

environment.

Executable JAR

Java applications are also distributed as JAR file that can be launched with java -jar

command.

When you create a project (or a fixture – more about it later) – you need to select an

appropriate launcher that correspond to the way your application is launched. MarathonITE

provides launchers for Java command line, web start, applet, executable jar and command

line.

In this tutorial, we shall use java command line launcher to start the application. The User

Guide explains all other types of launchers in detail.

2.3.1.1. Application Under Test - SwingSet3

In this tutorial we will use SwingSet3 (https://github.com/jalian-systems/swingset3).

SwingSet3 is a swing demonstration application. All most all of the standard swing

components are used in this application and as such a great application for testing

MarathonITE features.

https://github.com/jalian-systems/swingset3


(http://marathonite-userguide.com/wp-content/uploads/2019/02/SwingSet3-1024x807.png)

A copy of the SwingSet3 application is distributed with MarathonITE. You can find it in the

swingset3 folder of your MarathonITE installation.

2.3.1.2. Creating a Project

In MarathonITE, a project holds all the testing project resources. Let us start by creating a new

project for the SwingSet3 application.

If you have MarathonITE running, quit it. And start marathonite without any arguments.

http://marathonite-userguide.com/wp-content/uploads/2019/02/SwingSet3-1024x807.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_-

_New_Project.png)

MarathonITE displays a project selection dialog. The project selection dialog allows you to

create, modify projects. From the project selection, click on the New and from the displayed

options select Java/Swing Project.

MarathonITE opens up a new project dialog.

Configuring the Project

MarathonITE project configuration is provided in 3 sections which are displayed as tabs in the

dialog. Generic information regarding the project is given in the Project tab, the default fixture

configuration is provided in the Application tab and script language settings in the Language

tab.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_-_New_Project.png


Project Tab

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Tab.png)

In the project tab, provide the name of the project and use the Browse button to select an

empty folder to save the project. Optionally you can provide Description. We shall leave the

pattern fields as empty for this tutorial.

Click on the Application tab.

Application Tab

MarathonITE borrows the concept of Fixtures from xUnit family of testing frameworks. A fixture

defines how an application is launched from MarathonITE and also provides setup and

teardown methods that are executed at the beginning and end of a test script respectively. A

MarathonITE project can have more than one fixture. The application tab is used to create a

default fixture.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Tab.png


Application tab allows you to select a launcher and appropriate information required for the

launcher. For this example, we will use Java Command Line Launcher.

From the launcher combobox, select Java Command Line Launcher. You will be presented

with two tabs – Main and Class Path.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-

_Main.png)

When Java command line launcher is used, MarathonITE constructs a java command line in

the following form and executes it.

We need to provide all the information required to construct the command to MarathonITE. In

the Main tab, provide the class name com.sun.swingset3.SwingSet3 – which is the main class

used to launch SwingSet3 application. You can optionally enter Program Arguments and VM

Arguments in the fields. If your application needs to start from a specific directory, you can

specify Working Directory by clicking on Browse and selecting a folder. Though MarathonITE

1  java [vm-arguments] -cp [class-path-entries] [main-class-name] [program-arguments

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_Main.png


needs Java 1.8+ to work, your application can still use a di"erent version of Java. You can use

the Java Home field to specify that. For this tutorial, enter -Xmx512m in the VM Arguments

and leave rest of the fields empty.

Click on the Class Path tab.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Application_Tab_Class_Path.png)

Use the Add Archives button to add SwingSet3.jar and all other JAR files in the swingset3/lib

folder. You can also use Add Folders option and add di"erent folders to the class path, though

it is not required in this case.

Now select Language Tab.

Language Tab

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Class_Path.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png)

Language tab allows you to select the scripting language and customize the language runtime

used in MarathonITE scripts. At this time MarathonITE supports Ruby (https://www.ruby-

lang.org/en/) and we intend to support other languages. For this example, there is nothing we

need to customize in this tab.

Testing the Configuration

You can test the configuration and check for any errors by using the Test option. When you

select the option, MarathonITE uses the given configuration to launch the application.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png
https://www.ruby-lang.org/en/


(http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-window.png)

If everything is fine, your application should launch. Once MarathonITE is able to connect to

the application – a window is shown. The window shows the standard output and error from

the command – you can see any errors if the application is not launched.

Click on the Close button. This should close the application.

Saving the Project

Click on the Save button to save the project. MarathonITE will close the project configuration

window and you are presented with the project selection dialog with the newly created project

already select.

http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-window.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_Project_Selected.png)

Click on the Select button to start MarathonITE with the new project.

2.3.1.3. Recording a Test

MarathonITE provides an inbuilt recorder that you can use to record your test script. For

recording a test script, follow the below steps:

1. Create a new test script

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_Project_Selected.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar_new-1.png)

From the File -> New select New Test Case option. Alternatively, you can use the

toolbar button or press Ctrl+N to create a new test case. MarathonITE opens an Untitled test

case in a new editor. The cursor is appropriately positioned so that you can start recording.

2. Start recording

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record-1.png)

You can start recording your script. Use the Record toolbar button for starting the

recording. Alternatively, you can use the Marathon -> Record menu item or use Ctrl+R

keystroke to start recording.

MarathonITE starts a new recording. You will see a Wait message and MarathonITE starts

your application. The main window is closed and a Control Center window is displayed.

3. Perform operations on the application

You can use the application as it is used normally. Each of the operations performed are

recorded as script elements by MarathonITE. The control center window displays the

recordings of the last few operations.

For this test, we click on the TextField option from the le! side menu. This option provides

a demonstration of text input components of swing. Note that the control center shows

select(“TextField”, “true”) recording. Since the options are implemented using

JToggleButtons, a select statement is recorded. For normal buttons, a click will be

recorded.

http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar_new-1.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record-1.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/swingset3-textfield-

operations.png)

Enter ‘Aug 15, 1947’ in the date field and click on the Go button. Observe the recording in

the control center and a ‘Friday’ should have been displayed next to the Go button.

4. Adding assertions

A good test case not only includes the sequence of operations, but also includes

checkpoints that verify that the operations are processed correctly. While using

MarathonITE you can add assertions to the script by using the assertion window.

http://marathonite-userguide.com/wp-content/uploads/2019/02/swingset3-textfield-operations.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Assertions_Window.png)

Move the mouse cursor to the Friday label, and click mouse right button while control key

is pressed. MarathonITE displays an Assertions window. You can include assertions for any

properties for the currently selected component into the script. Select the Text{Friday}

property and click on the Insert Assertion option of the bottom of the window.

MarathonITE inserts an assert_p call into the script. Close the window by pressing ESCAPE

key or clicking on the close button.

5. Finish recording

http://marathonite-userguide.com/wp-content/uploads/2019/02/Assertions_Window.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Marathon_Control_Center.png)

We completed recording of our first test. You can finish the recording by clicking on the Stop

Recording button on the control center window. MarathonITE will display the main window

again – now the script editor will contain the recorded script.

6. Save test script

Use File -> Save option to save the test script into a file. We save it as date_test.rb.

2.3.1.4. Anatomy of a Test Script

In this section we have a quick look at the recorded test. By the time you finish recording the

earlier test, the editor should have the following recorded test:

1. require_fixture

The require_fixture statement within the marathon marker block, identifies the fixture to be

1
2
3
4
5
6
7
8
9
10
11
12
13

#{{{ Marathon
require_fixture 'default'
#}}} Marathon
 
def test
    with_window("SwingSet3") {
        select("TextField", "true")
        select("tfDow", "Aug 15, 1947")
        click("Go")
        assert_p("lbl:Friday", "Text", "Friday")
    }
 
end

http://marathonite-userguide.com/wp-content/uploads/2019/02/Marathon_Control_Center.png


used for running the test script. You can have multiple fixtures in your project – each one

di"ering either by the way the application is launched or by setting up test environment.

2. test method

All MarathonITE test scripts have test entry point. This is the entry point for the test and

executed a!er the fixture setup method.

3. select

select is MarathonITE‘s main method for setting the state of a component. This method

takes an object name and a value in most cases. The object name is used to look into the

object map to find the recognition properties and the state of the object is set using the

value.

4. click

click does what you expect it to do.

5. assert_p

MarathonITE uses assert_p to add a check point to the script. The parameters are the object

name, the property and the expected value.

6. with_window

with_window sets the top level context in which the other statements need to be executed.

MarathonITE changes the object map context to the given window name as well as

informing the Java driver (the selenium/webdriver for Java applications) to

switch_window.

2.3.1.5. Running Tests

You have multiple ways of running tests using MarathonITE. You can run the test currently

loaded into the script editor, run multiple tests using the Test Runner view or use batch mode

to run the test scripts without the UI.

Now that you know how to record a test, you can go ahead and record more tests. This tutorial

shows with a single test – however, the same applies to multiple test scripts.

Running a single test from the editor



(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Main_window_with_test_loaded.png)

Ensure your test script is loaded into the current editor. Use the Navigator to open the test

script if it is not already open.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button-1.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Main_window_with_test_loaded.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button-1.png


With the test script loaded into the editor, select Marathon -> Play button to execute the

test. Alternatively, you can use Control+P key stroke or the Play button on the toolbar.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View.png)

MarathonITE executes the test. The results are shown in the Results view. You might not have

anything in the result view if the test case is executed without any errors or failures.

Running tests using Test Runner

MarathonITE includes a test runner view to execute multiple tests.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Test_Runner_view.png)

Select the TestCases folder from the Navigator view and select Play option from the context

menu displayed when you rightclick. MarathonITE opens a TestRunner view and executes all

the tests from the folder.

If there are any failures or errors in the test scripts, the details are shown in the Trace section of

the Test Runner view.

Runing tests in batch mode

You can run tests using MarathonITE batch mode. For running all tests from the project use the

following command:

1 marathonite -batch [path-to-the-folder] AllTests

http://marathonite-userguide.com/wp-content/uploads/2019/02/Test_Runner_view.png


MarathonITE creates a marathonite-reports folder in which the results of the tests are written.

You can select only some tests to execute using various options of marathonite command.

2.3.1.6. Looking at Results

When you execute the test script from the editor – the results are shown in the Results section

of the window. Each entry contains the message, the file name and the location of the error.

Doubleclicking on an entry opens the file and positions the cursor at the failing line.

By default, MarathonITE doesn’t generate a report for a test run from the editor. You can

change this behavior by toggling the Marathon -> Generate Reports menu option.

When you run a test script when this option is selected, you can look at the report by clicking

on the Show Report button on the toolbar.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png


When the tests are executed using the test runner, the results are shown with a success/failure

indicator. When you select a test, the Trace section of the Test Runner view shows the stack

trace if any of the failed test. Doubleclicking on a stacktrace entry opens the corresponding file

and positions the cursor at the failing line.

MarathonITE always generates a report for the test runs from the test runner view. You can

click on the Test Runner‘s toolbar button Show Report to see the report.

When the tests are executed using batch mode, MarathonITE generate reports in marathon-

reports folder. You can change this folder using --report option of the command line.

MarathonITE uses Allure Reporting framework (). The reports are generateed are rich and use

HTML/CSS/Java script. While opening a report works in Mozilla Firefox™, it doesn’t work with

all the browsers.

You can use allure-commandline package to see the report. A copy of which is distributed

in allure folder of installation. Following command opens a report in the default browser.

2.3.2. Java/FX™ Test Project

A typical Java/FX™ application is a set of class files bundled together in one or more Java

Archives (jar) files. In all these classes, there is a special class that has a main method that is

the entry point into the application. Once you know the main class and have the list of JAR

files, the application is launched as follows:

As this is a cumbersome way of launching an application, Java (and 3rd parties) provide a set

of tools to ease the deployment of the applications.

Java Webstart™
Java Web Start is a framework developed by Sun Microsystems (now Oracle) that allows

users to start application so!ware for the Java Platform directly from the Internet using a

1 allure report open --report-dir marathon-reportsreports

1  java -cp <list-of-jar-files> <main-class-name> <application-arguments>

http://marathonite-userguide.com/


web browser. The launch information of the application is provided in a JNLP file. The file

along with the application JAR files are stored in an accessible location for the user. The

user needs to download the JNLP file and use javaws tool to launch the application. Java

web start is also integrated into most desktop operating systems. So opening a JNLP file

automatically launches the application.

Executables and Batch files

Java applications are also typically wrapped as exeutable files or batch files. When the user

runs this file, the arguments and the environment is processed and a properly constructed

java command line is executed.

Applets

Some java applications are deployed as applets. The applets are executed within a browser

environment.

Executable JAR

Java applications are also distributed as JAR file that can be launched with java -jar

command.

When you create a project (or a fixture – more about it later) – you need to select an

appropriate launcher that correspond to the way your application is launched. MarathonITE

provides launchers for Java command line, web start, executable jar and command line to

launch FX applications.

In this tutorial, we shall use java command line launcher to start the application. The User

Guide explains all other types of launchers in detail.

2.3.2.1. Application Under Test - Ensemble

In this tutorial we will use Ensemble8.



Ensemble8 is a gallery of sample applications that demonstrate a large variety of

JavaFX features, including animation, charts, and controls. You can view and

interact with each running sample on ALL platforms, and read its descriptions.

On the desktop platforms, you can copy each sample’s source code, adjust the

properties of the sample components used in several samples, and follow links to

the relevant API documentation when you’re connected to the Internet.

http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble8-demo-1.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble8-demo-1.png)

Ensemble8 is part of the JDK samples. You can download it from Java SE Downloads

(http://www.oracle.com/technetwork/java/javase/downloads/) page.

2.3.2.2. Creating a Project

In MarathonITE, a project holds all the testing project resources. Let us start by creating a new

project for the Ensemble application.

If you have MarathonITE running, quit it. And start marathonite without any arguments.

http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble8-demo-1.png
http://www.oracle.com/technetwork/java/javase/downloads/
http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_FX_Project_Selected.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_FX_Project_Selected.png)

MarathonITE displays a project selection dialog. The project selection dialog allows you to

create, modify projects. From the project selection, click on the New and from the displayed

options select Java/FX Project.

MarathonITE opens up a new project dialog.

Configuring the Project

MarathonITE project configuration is provided in 3 sections which are displayed as tabs in the

dialog. Generic information regarding the project is given in the Project tab, the default fixture

configuration is provided in the Application tab and script language settings in the Language

tab.

Project Tab

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_FX_Tab.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_FX_Project_Selected.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_FX_Tab.png


In the project tab, provide the name of the project and use the Browse button to select an

empty folder to save the project. Optionally you can provide Description. We shall leave the

pattern fields as empty for this tutorial.

Click on the Application tab.

Application Tab

MarathonITE borrows the concept of Fixtures from xUnit family of testing frameworks. A fixture

defines how an application is launched from MarathonITE and also provides setup and

teardown methods that are executed at the beginning and end of a test script respectively. A

MarathonITE project can have more than one fixture. The application tab is used to create a

default fixture.

Application tab allows you to select a launcher and appropriate information required for the

launcher. For this example, we will use Java Command Line Launcher.

From the launcher combobox, select Java Command Line Launcher. You will be presented

with two tabs – Main and Class Path.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-FX-

_Main.png)

When Java command line launcher is used, MarathonITE constructs a java command line in

the following form and executes it.

We need to provide all the information required to construct the command to MarathonITE. In

the Main tab, provide the class name ensemble.EnsembleApp – which is the main class used to

launch Ensemble application. You can optionally enter Program Arguments and VM

Arguments in the fields. If your application needs to start from a specific directory, you can

specify Working Directory by clicking on Browse and selecting a folder. Though MarathonITE

needs Java 1.8+ to work, your application can still use a di"erent version of Java. You can use

the Java Home field to specify that. For FX applications it should also be 1.8+. For this tutorial,

enter -Xmx512m in the VM Arguments and leave rest of the fields empty.

Click on the Class Path tab.

1  java [vm-arguments] -cp [class-path-entries] [main-class-name] [program-arguments

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-FX-_Main.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Application_Tab_FX_Class_Path.png)

Use the Add Archives button to add Ensemble8.jar. You can also use Add Folders option and

add di"erent folders to the class path, though it is not required in this case.

Now select Language Tab.

Language Tab

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_FX_Class_Path.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png)

Language tab allows you to select the scripting language and customize the language runtime

used in MarathonITE scripts. At this time MarathonITE supports Ruby (https://www.ruby-

lang.org/en/) and we intend to support other languages. For this example, there is nothing we

need to customize in this tab.

Testing the Configuration

You can test the configuration and check for any errors by using the Test option. When you

select the option, MarathonITE uses the given configuration to launch the application.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png
https://www.ruby-lang.org/en/


(http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-FX-window.png)

If everything is fine, your application should launch. Once MarathonITE is able to connect to

the application – a window is shown. The window shows the standard output and error from

the command – you can see any errors if the application is not launched.

Click on the Close button. This should close the application.

Saving the Project

http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-FX-window.png


Click on the Save button to save the project. MarathonITE will close the project configuration

window and you are presented with the project selection dialog with the newly created project

already select.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_FX_Project_Selected-1.png)

Click on the Select button to start MarathonITE with the new project.

2.3.2.3. Recording a Test

MarathonITE provides an inbuilt recorder that you can use to record your test script. For

recording a test script, follow the below steps:

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_FX_Project_Selected-1.png


1. Create a new test script

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar_new_fx.png)

From the File -> New select New Test Case option. Alternatively, you can use the

toolbar button or press Ctrl+N to create a new test case. MarathonITE opens an Untitled test

case in a new editor. The cursor is appropriately positioned so that you can start recording.

2. Start recording

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record_fx.png)

You can start recording your script. Use the Record toolbar button for starting the

recording. Alternatively, you can use the Marathon -> Record menu item or use Ctrl+R

keystroke to start recording.

MarathonITE starts a new recording. You will see a Wait message and MarathonITE starts

your application. The main window is closed and a Control Center window is displayed.

3. Perform operations on the application

You can use the application as it is used normally. Each of the operations performed are

recorded as script elements by MarathonITE. The control center window displays the

recordings of the last few operations.

For this test, we select the FXML Login Demo option. Click on the List option on the toolbar,

then select Language option and followed by FXML Login Demo option.

http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar_new_fx.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record_fx.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble-fxml-login-

demo.png)

Enter demo for both user name and password fields and click on Login button.

4. Adding assertions

A good test case not only includes the sequence of operations, but also includes

checkpoints that verify that the operations are processed correctly. While using

MarathonITE you can add assertions to the script by using the assertion window.

http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble-fxml-login-demo.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble-assertion-

window.png)

Move the mouse cursor to the Please review your profile label, and click mouse right

button while control key is pressed. MarathonITE displays an Assertions window. You can

include assertions for any properties for the currently selected component into the script.

Select the Text{Please review your profile} property and click on the Insert Assertion option

of the bottom of the window. MarathonITE inserts an assert_p call into the script. Close the

window by pressing ESCAPE key or clicking on the close button.

5. Finish recording

http://marathonite-userguide.com/wp-content/uploads/2019/02/ensemble-assertion-window.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Marathon_Control_Center-ensemble.png)

We completed recording of our first test. You can finish the recording by clicking on the Stop

Recording button on the control center window. MarathonITE will display the main window

again – now the script editor will contain the recorded script.

6. Save test script

Use File -> Save option to save the test script into a file. We save it as login_test.rb.

2.3.2.4. Anatomy of a Test Script

In this section we have a quick look at the recorded test. By the time you finish recording the

earlier test, the editor should have the following recorded test:

1. require_fixture

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17

#{{{ Marathon
require_fixture 'default'
#}}} Marathon
 
severity("normal")
 
def test
    with_window("Ensemble") {
        select("list", "true")
        click("list-view_1", "Language")
        click("list-view_2", "FXML Login Demo")
        select("textField1", "demo")
        select("passwordField1", "demo")
        click("button1")
        assert_p("Please review your profile.", "text", "Please review your profile."
    }
end

http://marathonite-userguide.com/wp-content/uploads/2019/02/Marathon_Control_Center-ensemble.png


The require_fixture statement within the marathon marker block, identifies the fixture to be

used for running the test script. You can have multiple fixtures in your project – each one

di"ering either by the way the application is launched or by setting up test environment.

2. test method

All MarathonITE test scripts have test entry point. This is the entry point for the test and

executed a!er the fixture setup method.

3. select

select is MarathonITE‘s main method for setting the state of a component. This method

takes an object name and a value in most cases. The object name is used to look into the

object map to find the recognition properties and the state of the object is set using the

value.

4. click

click does what you expect it to do.

5. assert_p

MarathonITE uses assert_p to add a check point to the script. The parameters are the object

name, the property and the expected value.

6. with_window

with_window sets the top level context in which the other statements need to be executed.

MarathonITE changes the object map context to the given window name as well as

informing the Java driver (the selenium/webdriver for Java applications) to

switch_window.

2.3.2.5. Running Tests

You have multiple ways of running tests using MarathonITE. You can run the test currently

loaded into the script editor, run multiple tests using the Test Runner view or use batch mode

to run the test scripts without the UI.

Now that you know how to record a test, you can go ahead and record more tests. This tutorial

shows with a single test – however, the same applies to multiple test scripts.

Running a single test from the editor



(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Main_window_with_test_loaded_ensemble.png)

Ensure your test script is loaded into the current editor. Use the Navigator to open the test

script if it is not already open.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Play_button_ensemble.png)

With the test script loaded into the editor, select Marathon -> Play button to execute the

test. Alternatively, you can use Control+P key stroke or the Play button on the toolbar.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Main_window_with_test_loaded_ensemble.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button_ensemble.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View.png)

MarathonITE executes the test. The results are shown in the Results view. You might not have

anything in the result view if the test case is executed without any errors or failures.

Running tests using Test Runner

MarathonITE includes a test runner view to execute multiple tests.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Test_Runner_view_ensemble.png)

Select the TestCases folder from the Navigator view and select Play option from the context

menu displayed when you rightclick. MarathonITE opens a TestRunner view and executes all

the tests from the folder.

If there are any failures or errors in the test scripts, the details are shown in the Trace section of

the Test Runner view.

Runing tests in batch mode

http://marathonite-userguide.com/wp-content/uploads/2019/02/Test_Runner_view_ensemble.png


You can run tests using MarathonITE batch mode. For running all tests from the project use the

following command:

MarathonITE creates a marathonite-reports folder in which the results of the tests are written.

You can select only some tests to execute using various options of marathonite command.

2.3.2.6. Looking at Results

When you execute the test script from the editor – the results are shown in the Results section

of the window. Each entry contains the message, the file name and the location of the error.

Doubleclicking on an entry opens the file and positions the cursor at the failing line.

By default, MarathonITE doesn’t generate a report for a test run from the editor. You can

change this behavior by toggling the Marathon -> Generate Reports menu option.

When you run a test script when this option is selected, you can look at the report by clicking

on the Show Report button on the toolbar.

1 marathonite -batch [path-to-the-folder] AllTests



(http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png)

When the tests are executed using the test runner, the results are shown with a success/failure

indicator. When you select a test, the Trace section of the Test Runner view shows the stack

trace if any of the failed test. Doubleclicking on a stacktrace entry opens the corresponding file

and positions the cursor at the failing line.

MarathonITE always generates a report for the test runs from the test runner view. You can

click on the Test Runner‘s toolbar button Show Report to see the report.

When the tests are executed using batch mode, MarathonITE generate reports in marathon-

reports folder. You can change this folder using --report option of the command line.

MarathonITE uses Allure Reporting framework (). The reports are generateed are rich and use

HTML/CSS/Java script. While opening a report works in Mozilla Firefox™, it doesn’t work with

all the browsers.

You can use allure-commandline package to see the report. A copy of which is distributed

in allure folder of installation. Following command opens a report in the default browser.

http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png
http://marathonite-userguide.com/


2.3.3. Web Application Test Project

In general usage, a web application (or webapp for short) is implemented using a client/server

architecture. Where as the server so!ware may reside on a remote server machine, the client

(or the user interface) of the application makes use of a web browser.

Recent advances like AJAX, HTML5 etc., are moving the boundaries of web applications. The

sophisticated UI provided by web applications reaches the quality of desktop applications.

General purpose techiniques like drag and drop, cut and paste are all supported by web

applications now.

You can use MarathonITE to test your web applications. MarathonITE uses

Selenium/WebDriver bindings internally and provide you with recording and playback

capabilities to test most facets of your applications.

Note: At this time MarathonITE supports only http protocol for recording the tests when using

browsers other than Chrome. In this tutorial, we will be using Chrome browser to create a test

script. Playback is supported on all other browsers.

2.3.3.1. Application Under Test - DuckDuckGo Search

In this tutorial we will use DuckDuckGo search engine.

1 allure report open --report-dir marathon-reportsreports



DuckDuckGo (DDG) is an Internet search engine that emphasizes protecting

searchers’ privacy and avoiding the filter bubble of personalized search results.

DuckDuckGo distinguishes itself from other search engines by not profiling its

users and by deliberately showing all users the same search results for a given

search term. DuckDuckGo emphasizes returning the best results, rather than the

most results, and generates those results from over 400 individual sources,

including key crowdsourced sites such as Wikipedia, and other search engines

like Bing, Yahoo!, Yandex, and Yummly. – Wikipedia

(http://marathonite-userguide.com/wp-content/uploads/2019/02/duckduckgo.png)

2.3.3.2. Creating a Project

http://marathonite-userguide.com/wp-content/uploads/2019/02/duckduckgo.png


In MarathonITE, a project holds all the testing project resources. Let us start by creating a new

project for the DuckDuckGo application.

If you have MarathonITE running, quit it. And start marathonite without any arguments.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Application_Project_Sel

ected.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Application_Project_Selected.png


MarathonITE displays a project selection dialog. The project selection dialog allows you to

create, modify projects. From the project selection, click on the New and from the displayed

options select Web Application Project.

MarathonITE opens up a new project dialog.

Configuring the Project

MarathonITE project configuration is provided in 3 sections which are displayed as tabs in the

dialog. Generic information regarding the project is given in the Project tab, the default fixture

configuration is provided in the Application tab and script language settings in the Language

tab.

Project Tab

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_WebApp_Tab.png)

In the project tab, provide the name of the project and use the Browse button to select an

empty folder to save the project. Optionally you can provide Description. We shall leave the

pattern fields as empty for this tutorial.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_WebApp_Tab.png


Click on the Application tab.

Application Tab

MarathonITE borrows the concept of Fixtures from xUnit family of testing frameworks. A fixture

defines how an application is launched from MarathonITE and also provides setup and

teardown methods that are executed at the beginning and end of a test script respectively. A

MarathonITE project can have more than one fixture. The application tab is used to create a

default fixture.

Application tab allows you to select a launcher and appropriate information required for the

launcher. We will use Web Application Launcher designed for launching web applications

using a browser.

From the launcher combobox, select Web Application.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Web-

1.png)

Enter the website URL – https://duckduckgo.com into the URL (Prefix) field. For this example,

we can leave the Start Path field empty. Select Chrome as the Default Browser. You can select

initial browser window size by setting the Initial Window Size options.

Note: When using https protocol you can use only Chrome browser for recording. You can,

ofcourse, use other browsers for playing back the scripts.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Web-1.png


Now select Language Tab.

Language Tab

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png)

Language tab allows you to select the scripting language and customize the language runtime

used in MarathonITE scripts. At this time MarathonITE supports Ruby (https://www.ruby-

lang.org/en/) and we intend to support other languages. For this example, there is nothing we

need to customize in this tab.

Testing the Configuration

You can test the configuration and check for any errors by using the Test option. When you

select the option, MarathonITE uses the given configuration to launch and connect to the

webdriver.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png
https://www.ruby-lang.org/en/


(http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-Web-window.png)

Once MarathonITE is able to connect to the driver – a window is shown. The window shows the

standard output and error from the command – you can see any errors if MarathonITE is

unable to connect to the webdriver intsance.

Click on the Close button. This should close the window.

Saving the Project

http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-Web-window.png


Click on the Save button to save the project. MarathonITE will close the project configuration

window and you are presented with the project selection dialog with the newly created project

already select.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Project_Selected.png)

Click on the Select button to start MarathonITE with the new project.

2.3.3.3. Recording a Test

MarathonITE provides an inbuilt recorder that you can use to record your test script. For

recording a test script, follow the below steps:

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Project_Selected.png


1. Create a new test script

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-new-web.png)

From the File -> New select New Test Case option. Alternatively, you can use the

toolbar button or press Ctrl+N to create a new test case. MarathonITE opens an Untitled test

case in a new editor. The cursor is appropriately positioned so that you can start recording.

2. Start recording

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-

record_web.png)

You can start recording your script. Use the Record toolbar button for starting the

recording. Alternatively, you can use the Marathon -> Record menu item or use Ctrl+R

keystroke to start recording.

MarathonITE starts a new recording. You will see a Wait message and MarathonITE starts

your application in the browser. The main window is closed and a Control Center window is

displayed.

3. Perform operations on the application

You can use the application as it is used normally. Each of the operations performed are

recorded as script elements by MarathonITE. The control center window displays the

recordings of the last few operations.

For this test, we perform a simple search operation. Enter Hello World into the search field

and press ENTER. DuckDuckGo search is performed and the results are shown in the

browser.

http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-new-web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record_web.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/duckduckgo-search-

results.png)

4. Adding assertions

A good test case not only includes the sequence of operations, but also includes

checkpoints that verify that the operations are processed correctly. While using

MarathonITE you can add assertions to the script by using the assertion window.

http://marathonite-userguide.com/wp-content/uploads/2019/02/duckduckgo-search-results.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Assertions_Window_Web.png)

Move the mouse cursor to the first result in the search results and press Control+RightClick.

You can include assertions for any properties for the currently selected component into the

script. Select the Text property and click on the Insert Assertion option of the bottom of the

window. MarathonITE inserts an assert_p call into the script. Close the window by clicking

on the close button.

5. Finish recording

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Marathon_Control_Center_Web.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Assertions_Window_Web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Marathon_Control_Center_Web.png


We completed recording of our first test. You can finish the recording by clicking on the Stop

Recording button on the control center window. MarathonITE will display the main window

again – now the script editor will contain the recorded script.

6. Save test script

Use File -> Save option to save the test script into a file. We save it as search_test.rb.

2.3.3.4. Anatomy of a Test Script

In this section we have a quick look at the recorded test. By the time you finish recording the

earlier test, the editor should have the following recorded test:

1. require_fixture

The require_fixture statement within the marathon marker block, identifies the fixture to be

used for running the test script. You can have multiple fixtures in your project – each one

di"ering either by the way the application is launched or by setting up test environment.

2. test method

All MarathonITE test scripts have test entry point. This is the entry point for the test and

executed a!er the fixture setup method.

3. select

select is MarathonITE‘s main method for setting the state of a component. This method

takes an object name and a value in most cases. The object name is used to look into the

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18

#{{{ Marathon
require_fixture 'default'
#}}} Marathon
 
severity("normal")
 
def test
 
    with_window("DuckDuckGo") {
        select_text("q", "Hello World")
        click_submit("S")
    }
 
    with_window("Hello World at DuckDuckGo") {
        assert_p(""Hello, World!" program - Wikipedia", "text", ""Hello, World!" program - Wikipedia"
    }
 
end



object map to find the recognition properties and the state of the object is set using the

value.

4. click

click does what you expect it to do.

5. assert_p

MarathonITE uses assert_p to add a check point to the script. The parameters are the object

name, the property and the expected value.

6. with_window

with_window sets the top level context in which the other statements need to be executed.

MarathonITE changes the object map context to the given window name as well as

informing the Web driver to switch_window.

2.3.3.5. Running Multiple Tests

You have multiple ways of running tests using MarathonITE. You can run the test currently

loaded into the script editor, run multiple tests using the Test Runner view or use batch mode

to run the test scripts without the UI.

Now that you know how to record a test, you can go ahead and record more tests. This tutorial

shows with a single test – however, the same applies to multiple test scripts.

Running a single test from the editor



(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Main_window_with_test_loaded_web.png)

Ensure your test script is loaded into the current editor. Use the Navigator to open the test

script if it is not already open.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button_web.png)

With the test script loaded into the editor, select Marathon -> Play button to execute the

test. Alternatively, you can use Control+P key stroke or the Play button on the toolbar.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Main_window_with_test_loaded_web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button_web.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View_Web.png)

MarathonITE executes the test. The results are shown in the Results view. You might not have

anything in the result view if the test case is executed without any errors or failures.

Running tests using Test Runner

MarathonITE includes a test runner view to execute multiple tests.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View_Web.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Test_Runner_view_Web.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Test_Runner_view_Web.png


Select the TestCases folder from the Navigator view and select Play option from the context

menu displayed when you rightclick. MarathonITE opens a TestRunner view and executes all

the tests from the folder.

If there are any failures or errors in the test scripts, the details are shown in the Trace section of

the Test Runner view.

Runing tests in batch mode

You can run tests using MarathonITE batch mode. For running all tests from the project use the

following command:

MarathonITE creates a marathonite-reports folder in which the results of the tests are written.

MarathonITE uses the default browser selected from the Browser option. You can override it

with -browser option.

You can select only some tests to execute using various options of marathonite command.

2.3.3.6. Looking at Results

When you execute the test script from the editor – the results are shown in the Results section

of the window. Each entry contains the message, the file name and the location of the error.

Doubleclicking on an entry opens the file and positions the cursor at the failing line.

By default, MarathonITE doesn’t generate a report for a test run from the editor. You can

change this behavior by toggling the Marathon -> Generate Reports menu option.

When you run a test script when this option is selected, you can look at the report by clicking

on the Show Report button on the toolbar.

1 marathonite -batch [path-to-the-folder] AllTests



(http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png)

When the tests are executed using the test runner, the results are shown with a success/failure

indicator. When you select a test, the Trace section of the Test Runner view shows the stack

trace if any of the failed test. Doubleclicking on a stacktrace entry opens the corresponding file

and positions the cursor at the failing line.

MarathonITE always generates a report for the test runs from the test runner view. You can

click on the Test Runner‘s toolbar button Show Report to see the report.

When the tests are executed using batch mode, MarathonITE generate reports in marathon-

reports folder. You can change this folder using --report option of the command line.

MarathonITE uses Allure Reporting framework (). The reports are generateed are rich and use

HTML/CSS/Java script. While opening a report works in Mozilla Firefox™, it doesn’t work with

all the browsers.

You can use allure-commandline package to see the report. A copy of which is distributed

in allure folder of installation. Following command opens a report in the default browser.

http://marathonite-userguide.com/wp-content/uploads/2019/02/allure-report.png
http://marathonite-userguide.com/


2.4. MarathonITE Sample Projects

3. User Guide

MarathonITE is a professional tool for creating automated test suites for Java/Swing™,

Java/FX™ and Web applications through the graphical user interface. Marathon supports

automated tests, semi automated tests and also an exploratory test mode for manual tests.

Like with any automation project, test automation also involves programming albeit to a

lesser extent.

You find major success in your test automation project if the project is considered as a

so!ware

development project and plan it accordingly. Depending on the size of an organization and

project

structure, di"erent teams might be involved in creating automated tests. We do not assume

that a user

of Marathon is knowledgeable in programming and thus try to provide as much details as

required for

using Marathon e"ectively.

3.1. Installation and Startup

MarathonITE is available as a ZIP archive that can be installed on any

platform that supports Java 1.8+. This includes: Windows™, Linux, Mac OS™
and various other operating systems that support Java.

1 allure report open --report-dir marathon-reportsreports



You can install di"erent versions of MarathonITE in di"erent locations. Most

MarathonITE configuration is stored within individual project files and will

not be overwritten by this.

System Requirements

For using MarathonITE you require a recent version of Java – as of this writing the latest

version is 1.8.0_121.

Recommended System Requirements

Any 64 bit system with Java 1.8+

Intel Core i5 or Intel Core i7 (the 3rd generation).

6 GB of RAM or more.

2GB diskspace required for MarathonITE installation and extra space for AUT and test

scripts.

1280 x 1024 or higher display resolution.

Mouse or other pointing device.

Minimal System Requirements

Any 32/64 bit system with Java 1.8+

Intel Core 2 Duo or higher.

2 GB of RAM or more.

2GB diskspace required for MarathonITE installation and extra space for AUT and test

scripts.

1280 x 1024 or higher display resolution.

Mouse or other pointing device.

Installation

You can install MarathonITE by just unzipping the distribution into a folder on your system.

MarathonITE

will be copied into marathonite- folder.

Ensure that you have permissions to access the installation folder while executing

MarathonITE

on Windows™. We found issues when executing MarathonITE installed into Program Files



folder. We

identified it to be caused by JRuby runtime used.

License File

You require a license file to operate MarathonITE once the free trial period is over. You should

have received

the license file marathonite.lic through email.

You need to place MarathonITE license file into your home folder. Alternatively, you can copy

the license file

into the marathonite- folder where MarathonITE is unzipped.

Starting MarathonITE

MarathonITE can be started using the included scripts (marathonite.bat for Windows™ and

marathonite for

Linux/Unix™ Systems). MarathonITE can be launched in the following modes:

GUI Mode

GUI mode is the default mode for executing MarathonITE. In this mode, you can record test

scripts, group

tests, execute them.

Batch Mode

Batch mode is used to execute test scripts unattended. You start this mode by providing a -

batch parameter

to the marathonite script.

Demo Mode

Demo mode is used to execute test scripts with delay between the statements. This mode is

useful for quick

demonstration of your application. You launch marathonite in this mode by providing both

-demo and

-batch options to the command.

Security Warnings when Using MarathonITE



When you launch MarathonITE or launch the Application Under Test (AUT) for

recording/playing test scripts

you might get a security warning from Windows™ firewall. This is normal as MarathonITE uses

network

protocols (WebSocket/HTTP and RMI) to communicate with the AUT. You should allow Java™
access to the

network and should not block it in order to allow test automation through MarathonITE.

3.2. MarathonITE User Interface

MarathonITE sports a tabbed user interface. We use Java/FX™ for the interface controls. In this

section, we will list out all the major user interface components of MarathonITE and also

discuss their usage in brief. Checkout the User Guide for more details about these interface

components.

Main Window



(http://marathonite-userguide.com/wp-content/uploads/2019/02/image_85-1024x735.png)

Most of the time you spend with MarahtonITE, you will be using the Main window. The main

window is made up of three distinct sections. The view section is to the le! and shows the

views that are currently open. The editor area is used to host various editors of MarathonITE

like the script editor, object map editor, CSV editor etc. To the bottom of the window, you have

the output section that includes the Results, Log and console tabs.

3.2.1. Views

MarathonITE provides various views to show the test scripts grouped in di"erent ways. Here

are some of the views supported by MarathonITE.

Navigator

http://marathonite-userguide.com/wp-content/uploads/2019/02/image_85-1024x735.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Navigator.png)

The Navigator shows you the file system view of the project. You can perform most file

operations like copying, editing and deleting files from the Navigator view.

Test Runner

http://marathonite-userguide.com/wp-content/uploads/2019/02/Navigator.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/test-runner-view.png)

Whenever you select some tests from other views like Navigator, Features etc. and play them, a

test runner view shows the status of the test run. The test runner view allows you to save

di"erent test runs, so that you can see their state as well as execute them again.

Suites View

http://marathonite-userguide.com/wp-content/uploads/2019/02/test-runner-view.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/suites-view.png)

Suites view shows all the test suites created in the project. From this view you can modify test

suites, copy/move tests between suites, run suite(s). You can edit a suite by selecting open

from the context menu.

Features View

http://marathonite-userguide.com/wp-content/uploads/2019/02/suites-view.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/features-view.png)

You can see all the features in your project using the Features view. From the features view you

can edit, copy/move tests between features and run selected features in the test runner.

Stories View

http://marathonite-userguide.com/wp-content/uploads/2019/02/features-view.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/stories-view.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/stories-view.png)

You can group your test scripts BDD Style using Features and Stories. The Stories view displays

the test scripts grouped by stories. From this view, you can edit or delete a story. You can move

test scripts between stories or run selected stories in test runner.

Issues View

(http://marathonite-userguide.com/wp-content/uploads/2019/02/issues-view.png)

Issues view displays the tests grouped by issues. You can provide a link to an issue manager

through a pattern and MarathonITE provides links to the Issue manager server for the test

scripts. From the issues view, you can edit, delete or run selected issues.

3.2.2. Editors

http://marathonite-userguide.com/wp-content/uploads/2019/02/stories-view.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/issues-view.png


MarathonITE includes inbuilt editors for various project resources.

Script Editor

(http://marathonite-userguide.com/wp-content/uploads/2019/02/script-editor.png)

The script editor is based on ACE () – a high performance editor designed for web and

integrated into MarathonITE using Java/FX™ WebView control. The script editor supports

syntax highlighting not only for Ruby scripts, but also for other file formats. You can perform all

normal operations for text editors like cut and paste, indenting, search and replace within the

editor itself.

Object Map Configuration Editor

http://marathonite-userguide.com/wp-content/uploads/2019/02/script-editor.png
http://marathonite-userguide.com/


(http://marathonite-userguide.com/wp-content/uploads/2019/02/object-map-configuration-

editor.png)

The Object Map Configuration editor allows you to easily modify the default properties used

for creating object map entries while recording a test script. You can add/delete/modify

various entries for containers as well as components from this editor interface.

Object Map Editor

(http://marathonite-userguide.com/wp-content/uploads/2019/02/object-map-editor.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/object-map-configuration-editor.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/object-map-editor.png


While recording test scripts, MarathonITE makes entries into the object map. You can use the

Object Map editor to modify the entries. Through this editor interface, you can edit the name

and properties used for recognizing a component. You can also use the editor to create new

entries in the object map.

CSV Editor

(http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor.png)

Though most of the times, you use an external editor like Excel or LibreO"ice to edit the CSV

files used for data driven testing, MarathonITE also includes a CSV editor. You can use it for

quickly editing existing data in the CSV files.

Test Suite Editor

http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/suite-editor.png)

You can group test scripts, features, stories and even suites themselves into a test suite. The

test suite editor allows you to edit a test suite.

Feature Editor

http://marathonite-userguide.com/wp-content/uploads/2019/02/suite-editor.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/feature-editor.png)

If you like to use BDD style grouping of test scrits, you can use Features and Stories. The

feature editor allows you to edit a feature. You can add test scripts to a feature through the

editor interface.

Issue Editor

http://marathonite-userguide.com/wp-content/uploads/2019/02/feature-editor.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/issue-editor.png)

You can use MarathonITE to group your tests under issues. If you use an Issue Manager, you

can use the issue manager pattern option in the project settings to link a test script to the

corresponding issue in the issue manager. You can use the issue editor to modify the test

scripts assigned to an issue. You can also change the status of an issue and provide a

description to the issue from the editor.

3.2.3. Output Views

MarathonITE provides three views of output, each one containing a di"erent output type. The

MarathonITE itself outputs on the terminal the exception stack trace and logging output.

http://marathonite-userguide.com/wp-content/uploads/2019/02/issue-editor.png


Results View

(http://marathonite-userguide.com/wp-content/uploads/2019/02/results-view.png)

When you run a test, the results view shows assertion failures or errors that occur during the

run. You can double click an entry in the result view to goto the file/line where the error

occured. The show message button shows more details about the error like exception

stacktrace.

Record and Playback Log

(http://marathonite-userguide.com/wp-content/uploads/2019/02/record-and-playback-log-

1024x326.png)

MarathonITE adds log messages to the record and playback log. The log is useful when

debugging the test scripts. Some of the entries have associated information – double clicking

them shows the extra information.

Output View

http://marathonite-userguide.com/wp-content/uploads/2019/02/results-view.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/record-and-playback-log-1024x326.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/output-1024x321.png)

The output view shows the console output from the application as well as from the scripts.

3.3. Creating Marathonite Test Projects

When using MarathonITE to automate your application tests, you start with a project. A

MarathonITE project is nothing but a folder in the file system. The project folder contains all

the resources and artifacts related to the project.

MarathonITE keeps the application launch information in Fixtures. You need to start the

application from within MarathonITE for testing it.

MarathonITE borrows the concept of Fixtures from JUnit. A fixture creates a known state for

running a test against the application. A MarathonITE fixture also provides setup and teardown

methods. These methods can perform operations before and a!er a test script. A project can

have many fixtures. Every test case specifies a fixture used with it.

Creating a new Project

For creating a new project, you need to start marathonite without any arguments.

http://marathonite-userguide.com/wp-content/uploads/2019/02/output-1024x321.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Application_Project_Sel

ected.png)

MarathonITE displays a project selection dialog. The project selection dialog allows you to

create or edit projects. From the project selection dialog, click on the New button.

MarathonITE displays a list of supported platforms. Currently the supported platforms are

Java/Swing™ Java/FX™ and Web. Select a platform from the list.

MarathonITE shows new project dialog.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Application_Project_Selected.png


Configuring the Project

There are three sections in a MarathonITE project configuration. You need to provide generic

information about the project in the Project section. In the Application section – you provide

default fixture configuration. You can customize the script run-time in the Language section.

Project Section

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_WebApp_Tab.png)

In the Name field, enter a name for the project. Use the Browse button and select a folder. You

can provide some free formatted text for the description field.

MarathonITE can link tests to various issues saved in an Issue Tracker. If you use a Issue tracker

system (like BugZilla or Jira), enter a URL pattern in the Issue Tracker pattern field. A %s in the

pattern field is the place holder for the Issue ID.

MarathonITE can also link test scripts to a test management system (TMS) like testlink. Enter a

URL pattern in the Test Management pattern field. A %s in the pattern field is the place holder

for a test case ID.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_WebApp_Tab.png


Language Section

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png)

Language section allows you to select a scripting language and customize it’s run-time.

Currently, MarathonITE supports Ruby language.

MarathonITE bundles a JRuby run-time. You can change the version of JRuby used by setting

the Ruby Home. Using a di"erent version of JRuby might not be compatible with MarathonITE.

Please use this override under advisement.

You can add more folders to ruby run-time using the Add Folders button and selecting a folder.

All the folders provided in the list will be added to the ruby run-time path. You can use the

script files from these folders using require statement in your scripts.

Application Section

http://marathonite-userguide.com/wp-content/uploads/2019/02/Language_Tab.png


MarathonITE creates a default fixture using the information from the application section. A

project can have many fixtures.

The selected platform defines the launchers available for each of the fixtures. In the

Application section, select an appropriate launcher from the drop-down menu.

1. Web Application – Web Application Launcher

You can use a Web Application launcher to test a web application. Any supported browser can

start the application.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Web-

2.png)

You configure the web application launcher by providing the following information:

1. URL(Prefix)

This is the initial part of the URL, typically the host name and the port number. You need to

provide the port number only if it is not default.

2. Start Path

This is rest of the URL. MarathonITE creates a complete URL for the application by joining

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Web-2.png


both URL and path.

3. Default Browser

The browser used by scripts by default. You can override this later through MarathonITE UI.

4. Initial Window Size

The size of the browser window. Whenever a script uses this fixture, the browser window is

set to this size.

2. Web, Java/Swing™ and Java/FX™ – No Launcher

The launcher ‘No Launcher’ doesn’t launch an application under test. You can integrate your

existing test suite into MarathonITE using this launcher.

Using this launcher you can implement tests that do not need the AUT. For example, this

launcher to develop tests that test a REST API.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-

_No_Launcher.png)

No further information is required for creating a launcher of this type.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_No_Launcher.png


Before You Start – Java/Swing™ and Java/FX™

Ensure that you are able to launch the application without any security prompts outside

marathon. You may not be able to use Marathon if security prompts are shown by the

application.

Check security prompt settings in Java Control Center.

Updating Policy Files

For using webstart/applet launchers you need to allow all permissions to MarathonITE‘s

recorder and player agents. Please update the javaws.policy and java.policy files in

lt;javahome>/lib/security folder.

You need to add the following lines to the above policy files:

Depending on the configuration, the javaws application might not be using the same JRE/JDK

used by MarathonITE. You can find the current JRE used by webstart in the

deployment.properties. For more details refer to Deployment Configuration File and

Properties (http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-

guide/properties.html).

The easiest way may be to search for all javaws.policy and java.policy files in the system and

add the above lines to them.

Warning

If the configuration is not proper, the MarathonITE might not respond for as much as 3

minutes. Please be patient.

3. Java/Swing™ and Java/FX™ – Java Commandline Launcher

When using this launcher, MarathonITE builds a command line to start the application. This is

the default launcher for Java applications.

1
2
3
4
5
6
7

  grant codeBase "${marathon.agent}" {
    permission java.security.AllPermission;
  };
 
  grant codeBase "${marathon.recorder}" {
    permission java.security.AllPermission;
  };

http://java.sun.com/j2se/1.5.0/docs/guide/deployment/deployment-guide/properties.html


The launcher has two sections.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_Main-

1.png)

In the Main section you should provide:

1. Class Name

The main class to start the application

2. Program Arguments

The arguments that are passed to the application

3. VM Arguments

The arguments that are passed to the java command

4. Working directory

The folder from which the application must be started

5. Java Home

if you want to use an alternative version of Java to launch the application.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_Main-1.png


(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Application_Tab_Class_Path-1.png)

In the Class Path section you need to provide the list of Jars and folders that make up the class

path.

4. Java/Swing™ and Java/FX™ – Command Line Launcher

If you launch your application using a executable or a batch script, you can use this launcher.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_Class_Path-1.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-

_Command_Line.png)

For creating a command line launcher, you need to provide the following information:

1. Command/Batch Script

Enter the path to the executable or the batch script in this field. If your command is in the

PATH, you do not need to provide the full path. You can use the Browse button and select a

command or script from the file system.

2. Working directory

The folder from which the application must be started

3. Window Title

In most cases, MarathonITE can identify application’s first window. Yet, if you find that

MarathonITE times out when you start the application (though the application itself starts)

set this field. In this field, provide the title of the first window of the application. The

Window Title field allows regular expressions – start your value with a ‘/’ character. The title

given here should be an exact match for the title of the first window of the application.

4. Program Arguments

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_Command_Line.png


The arguments that are passed to the application

5. VM Arguments

The arguments that are passed to the java command

6. Java Home

if you want to use an alternative version of Java to launch the application.

5. Java/Swing™ and Java/FX™ – WebStart Launcher

Java Web Start allows users to start an application from the Internet using a web browser. The

javaws command launches a web start application. The user provides a path to a JNLP file to

the command. The path can either be a local file or a URL.

MarathonITE provides a launcher that can launch a java application using javaws command.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-

_WebStart.png)

For using WebStart with MarathonITE, you create a web start launcher by providing the

following information:

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_WebStart.png


1. URL/File

Enter the URL to the JNLP file in this field. Alternatively, you can provide the path to a file

from the file system.

2. Window Title

In this field, provide the title of the first window of the application. The Window Title field

allows regular expressions – start your value with a ‘/’ character. The title given here should

be an exact match for the title of the first window of the application.

3. Program Arguments

The arguments that are passed to the application

4. VM Arguments

The arguments that are passed to the java command

5. Java Home

MarathonITE uses this field to find the javaws command to execute. However, you can’t

override the version of Java used with WebStart by setting this field.

6. Java/Swing™ and Java/FX™ – Executable Jar Launcher

Java allows you to distribute an application as a single JAR file. Most systems allow you to start

the application by double clicking the JAR file.

You can use the Executable JAR launcher to create a fixture that can test a JAR’red application.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-

_Executable_Jar.png)

For creating a fixture with this launcher, you need to provide the following information:

1. JAR File

Enter the path to the executable JAR in this field. You can use the Browse button and select

a command or script from the file system.

2. Working directory

The folder from which the application must be started

3. Window Title

In most cases, MarathonITE can identify application’s first window. Yet, if you find that

MarathonITE times out when you start the application (though the application itself starts)

set this field. In this field, provide the title of the first window of the application. The

Window Title field allows regular expressions – start your value with a ‘/’ character. The title

given here should be an exact match for the title of the first window of the application.

4. Program Arguments

The arguments that are passed to the application

http://marathonite-userguide.com/wp-content/uploads/2019/02/Application_Tab_-_Executable_Jar.png


5. VM Arguments

The arguments that are passed to the java command

6. Java Home

if you want to use an alternative version of Java to launch the application.

Testing the Configuration

You can test the configuration and check for any errors by using the Test option. When you

select

the option, MarathonITE uses the given configuration to launch and connect to the webdriver.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-Web-window.png)

Once MarathonITE is able to connect to the driver – a window is shown. The window shows the

standard output and error from the command – you can see any errors if MarathonITE is

unable to

connect to the webdriver intsance.

Click on the Close button. This should close the window.

Saving the Project

http://marathonite-userguide.com/wp-content/uploads/2019/02/test-app-Web-window.png


Click on the Save button to save the project. MarathonITE will close the project

configuration window and you are presented with the project selection dialog with the newly

created

project already select.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Project_Selected.png)

3.4. Recording Tests

MarathonITE includes a recorder that you use to record test scripts. Even when you manually

create a script, it is best to start with a recorded script. This will ensure that all accessed

components are available in the object map.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Project_Selection_Dialog_with_New_Web_Project_Selected.png


About Test Scripts

MarathonITE test scripts are regular Ruby scripts. MarathonITE adds some methods to the

language run-time. MarathonITE scripts are procedural in nature – this ties in with how you

think about tests.

Every test script starts executing at the test method. Before starting the script, MarathonITE

uses the defined fixture to start the application. Fixtures themselves are Ruby scripts. When

you create a new project, Marathon creates a default fixture in the Fixtures folder. You can use

fixtures to create a well-known state for the test case.

1. Selecting an Active Fixture

Before you start recording a test script – you need to select an active fixture. When you create a

project, MarathonITE selects default fixture as the active fixture.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/select-fixture.png)

You select an active fixture using Marathon -> Select Fixture… menu option. You

may also click on the active fixture shown in the status bar to open Select Fixture dialog. From

this dialog you can pick a fixture from the available fixtures.

http://marathonite-userguide.com/wp-content/uploads/2019/02/select-fixture.png


2. Create a New Test Script

Once an active fixture is selected, you should create a test script. Whenever a script is created,

MarathonITE records the active fixture in the script.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-new-web.png)

From the File -> New select New Test Case option. You can also use the toolbar button or

press Ctrl+N to create a new test case. MarathonITE opens an Untitled test case in a new editor.

The cursor is positioned so that you can start recording.

3. Recording a Script

(http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record_web.png)

You can start recording your script. Use the Record toolbar button for starting the recording.

Alternatively, you can use the Marathon -> Record menu item or use Ctrl+R keystroke to

start recording.

(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Marathon_Control_Center_Web.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-new-web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/toolbar-record_web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Marathon_Control_Center_Web.png


MarathonITE starts recording your actions on the AUT. You will see a Wait message and

MarathonITE starts your application. The main window is closed and a Control Center window

is displayed.

MarathonITE records any operations that you perform on the application. The Control Center

window displays the last few recorded operations.

MarathonITE records operations at a higher level than keyboard or mouse events. In most

cases, MarathonITE records the operation when a component looses focus.

Some of the operations that do not change the state of a component do not get recorded by

MarathonITE. For e.g, moving into a text-field and moving out without changing the text will

not record a operation.

4. Object Spy and Adding Checkpoints



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Assertions_Window.png)

While recording a script, you can use an object spy to inspect attributes of a component. While

keeping mouse pointer on a component, use Ctrl+rightclick to open the object spy

window. You can change the currently inspected component, by clicking another component

in the application. The Spy window will show the properties and values of the selected

component.

The object spy window is also called Assertions Window. From the object spy window, you can

insert assertions and wait calls into the test script.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Assertions_Window.png


For adding an assertion, select a property and click on the Insert Assertion button. You can

adda wait operation by clicking the Insert Wait button.

5. Other Operations

The following operations are available from the control center.

Pause

Pause recording the current script. Till you resume, MarathonITE doesn’t record the

operations on the application.

Insert Module

You can insert a MarathonITE module method. We will discuss more about re-usability in

later chapters.

Insert Checklist

You can insert a checklist into the script. When you execute the script, MarathonITE pauses

the script and shows the checklist. You can fill-up the checklist and include screenshots.

More about checklists in Semi Automated Tests chapter.

Raw Recording

By default, MarathonITE records high level operations rather than clicks and key events. By

selecting this option, you can let MarathonITE record raw events.

Script Console

Opens up a console window. You can execute any ruby commands to interact with the

application.

6. Complete Recording and Saving Test Scripts

When you complete your operations, you can stop the recording by clicking on the Stop

button. MarathonITE displays the main window with the recorded script in the editor.

Use File -> Save option to save the test script into a file.

3.5. Managing Checklists



It is not possible to automate all test scenarios. Even in these cases you can use MarathonITE

to simplify manual tests. You can let a script run under MarathonITE control till a point and

hand over the control to an user. The user can decide the success/failure state of the test case.

MarathonITE can get the control again and completes the script. We use checklists for

accomplishing this purpose in MarathonITE.

A checklist in MarathonITE is a manually entered success/failure status for a test. You can insert

a checklist into a test case – making it semi automatic. When played, MarathonITE pauses the

script at the checklist. You need to fill the checklist and save it for proceeding.

Checklists are also used while exploratory testing. You insert and fill up a checklist to record

the findings.

MarathonITE distribution ships with some checklists. You can create your own checklists or

edit the existing ones.

A Checklist is saved in XML format in the Checklists folder of a MarathonITE project

1. Elements of a Checklist

A name and description identifies a checklist. A checklist contains three di"erent types of

sections.

1. Header Sections

A header section helps in di"erentiating various parts of a checklist. You group various

other elements under a single header section.

2. Checklist Sections

A

checklist section includes a notes area. They also contain a radio group using which you can

make a test success/fail.

3. Textbox (Notes) Sections

A notes section provides a area where you can enter some descriptive text.

2. Creating New Checklist

From the File -> New menu, select New Check List option.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/new-checklist.png)

MarathonITE displays a New Check List window. Enter the name and description and click on

OK.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/checklist-editor.png)

MarathonITE displays the new checklist in a new editor.

http://marathonite-userguide.com/wp-content/uploads/2019/02/new-checklist.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/checklist-editor.png


Use the header, checklist and textbox buttons to add appropriate sections to the checklist. You

can reorganize sections by using the move up and move down buttons. Remove sections using

the remove button.

3. Editing and deleting checklists

You can edit a checklist by opening the corresponding checklist file from the Checklists folder.

You can remove a checklist by removing the corresponding checklist file from the Checklists

folder.

3.6. Exploratory Tests

Exploratory testing is an approach to so!ware testing that is concisely

described as simultaneous learning, test design and test execution.

Exploratory testers o!en use tools to record the session. These tools include screen capture or

video tools. They also use tools to analyze output, environment etc. to generate interesting

cases.

MarathonITE provides an exploratory mode of testing. During an exploratory test, MarathonITE

records the steps in the background. You can also include checklists, notes. MarathonITE

allows you to capture screenshots and annotate them.

1. Starting an Exploratory Test

You start exploratory testing in MarathonITE by using File -> New -> Exploratory

Test menu option. You can also use the keyboard short cut Ctrl+Shift+N to start an

exploratory test.

When you start an exploratory test, MarathonITE creates a new file for saving the actions.

MarathonITE also starts a recording session. While you exercise the application, MarathonITE

records the actions in the test script.



2. Recording Findings with Checklists

(http://marathonite-userguide.com/wp-content/uploads/2019/02/insert-checklist-

command.png)

If you want to record a finding, use the insert checklist command from the Control Center

window.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/inserting-a-checklist-

exploratory-test.png)

Marathon displays Select a Checklist dialog, select a checklist and click on Insert command.

http://marathonite-userguide.com/wp-content/uploads/2019/02/insert-checklist-command.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/inserting-a-checklist-exploratory-test.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/filling-a-checklist-

exploratory-test.png)

Marathon opens the checklist in a separate dialog. From this window, you can fill the checklist.

A!er filling the checklist, click on Save to save the checklist into the report.

In most cases you may want to use Note and Screenshot checklists during the exploratory

testing. You can also create your own checklists for using with exploratory testing.

3. Attaching a Screenshot

(http://marathonite-userguide.com/wp-content/uploads/2019/02/screncapture-exploratory-

test-1024x606.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/filling-a-checklist-exploratory-test.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/screncapture-exploratory-test-1024x606.png


You can attach a screenshot of the screen to the checklist by using Screen Capture button.

When you select the command, MarathonITE opens Screen Capture Annotation Window.

The annotation window displays the screenshot on the le! and a list of annotations to the

right. For adding an annotation, use the mouse and select an area on the image. MarathonITE

highlights the area selected and adds an empty annotation entry. Type any free form text into

the notes area.

Finally, save the screenshot by clicking on Save button.

4. Finishing Test and Sharing Results

You stop the test by using the stop button. Once the test is stopped Main window will display

the recorded script in an editor. A report is generated and saved in the TestReports folder. The

report is shown in the main window.

The test script itself is saved under Exploratory Tests folder within TestCases folder. The file is

named with a prefix of “et-” and a timestamp.

Every exploratory test run creates a report and is saved in the TestReports folder. The

index.html file in the reports directory is an HTML report for the test run. All resources referred

by

the report are also saved in the same directory. For sharing the report, just share that

directory. You may also share the test script to show the steps performed.

If you want to share the script, the whole project structure should be replicated on the other

machine.

3.7. Semi Automated Tests

It is not possible to automate all test scenarios in any given test project. There are always tests

that need manual intervention and subjective validation. It is still possible to use automation

for simplify these tests.



MarathonITE facilitates such Semi Automated tests through checklists. You record a normal

test. When the application reaches a point where you need a manual validation, insert a check

list. You can continue recording the test. You can also add more than one checklist per test

script.

These tests are also executed as normal tests. When the point of execution reaches a inserted

checklist, MarathonITE pauses. MarathonITE displays the checklist. Once you fill the checklist –

the execution of the test continues.

1. Use Cases for Semi Automatic Tests

The following are some cases where semi automatic tests will be very useful.

1. To check whether the application is following guidelines for UI

Most organizations have user interface guidelines. Checking whether the application

follows all guidelines is a monotonous job. Over a period of time it becomes tedious. Semi

automatic tests can help you simplify this process of verification. Start with converting the

guidelines into a checklist. For each of the application screen, create a script that opens up

that screen. Insert the guidelines checklist into the script.

When executing these tests, Marathonite performs actions as with regular scripts. When the

application reaches the screen, Marathonite displays the checklist. The tester can verify

each field for confirming to the guideline. In case of an issue, the tester can mark the test as

failed. He/She can also capture a screenshot and annotate it.

2. To check the validation criteria of fields

Automating tests for field validations is tedious and in some cases impossible. Some field

validations do not allow the application to proceed further. Some others may not even

allow submitting a form.

We designed semi automatic tests to handle these cases. Create field validation checklist

for each of the screens and attach them into a test script.

2. Creating a Semi Automated Test



(http://marathonite-userguide.com/wp-content/uploads/2019/02/inserting-a-checklist-

exploratory-test-1.png)

You create a Semi Automatic test by following the same recording procedure as it is for a

normal test. Reach the point in application where you need manual intervention. Insert a

checklist by clicking on the insert checklist button. MarathonITE shows a Select a Checklist

dialog.

Select a checklist from the available checklists and click on Insert button. MarathonITE adds

the checklist to the script using accept_checklist command.

If required, perform more operations and insert checklists at the points you desire. At the end,

stop the recording using the stop button.

3. Running Semi Automated Tests

By default, Marathonite ignores the accept_checklist commands in a test script. For

running tests that accept checklists, enable the option Enable Checklists from the Marathon

menu.

You can execute the semi automated tests either from the editor, the test runner view or using

batch mode.

http://marathonite-userguide.com/wp-content/uploads/2019/02/inserting-a-checklist-exploratory-test-1.png


Marathon pauses the script and displays the checklist when it reaches the

accept_checklist command. once you fill the checklist and save it, the script continues.

The report displays the information you enter in the checklists.

3.8. Executing Tests

Marathonite provides many ways of executing the tests. You can run the test in the current

editor. You can use the test runner view for running tests. Finally, you can use the batch mode.

In each of the following sections, we will look at each one of the options in detail.

3.8.1. Executing a Test from Editor



(http://marathonite-userguide.com/wp-

content/uploads/2019/02/Main_window_with_test_loaded_web.png)

Ensure your test script is loaded into the current editor. Use the Navigator to open the test

script if it is not already open.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button_web.png)

With the test script loaded into the editor, select Marathon -> Play button to execute the

test. Alternatively, you can use Control+P key stroke or the Play button on the toolbar.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Main_window_with_test_loaded_web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Play_button_web.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View_Web.png)

MarathonITE executes the test. The results are shown in the Results view. You might not have

anything in the result view if the test case is executed without any errors or failures.

Creating Reports

(http://marathonite-userguide.com/wp-content/uploads/2019/02/generate-reports-

option.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Results_View_Web.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/generate-reports-option.png


When you execute a test script, by default MarathonITE doesn’t generate reports. You can turn

on this option from the Marathon menu. You can also enable the checklists from the Marathon

menu.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/generated-report.png)

When the test is completed, MarathonITE generates a report. The generated report is saved in

the Test Reports folder. MarathonITE displays the report in a new tab.

A report might be very useful for a semi automated test.

3.8.1.1. Debugging Scripts

You can run a test in debug mode. When MarathonITE encounters a breakpoint it pauses the

script. For adding a breakpoint, position the cursor on a line of code and use Toggle

Breakpoint option from Marathon menu. You can also double click on the gutter to the le! of

the editor or use breakpoint button in toolbar. Marathon displays a breakpoint icon at the line.

You can play the test in debug mode by using Debug option in the Marathon menu or the

toolbar button. Marathon starts playing the script and when it reaches a line with a breakpoint

on it pauses the script.

http://marathonite-userguide.com/wp-content/uploads/2019/02/generated-report.png


Commands in Debug Mode

(http://marathonite-userguide.com/wp-content/uploads/2019/02/debug-toolbar.png)

The following commands are available when the script is paused in Debug mode:

Command Description

Step Into Steps into the method call. Useful for debugging the module scripts.

Step Over Steps over the method call.

Step Out Steps out of the current method. Marathon pauses at the statement a!er the

current method call.

Resume Resumes playing of the script. If Marathon encounters another breakpoint, it

again pauses the run.

Script

Console

Opens script console.

http://marathonite-userguide.com/wp-content/uploads/2019/02/debug-toolbar.png


3.8.1.2. Using Script Console

Script Console is available when you pause recording or playback. The console provides a way

for you to inspect the running application.

Typing help at the script console prompt gives a list of Marathon methods that are available.

You can execute any expression that evaluates to a value and assign it to a variable.

Script console maintains the command history between sessions. Use the UP and DOWN keys

to cycle through the history.

3.8.2. Executing Tests from Test Runner

You can run multiple tests in MarathonITE using the test runner view. You can open the test

runner view by selecting

multiple tests to execute.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-ui.png)

Running Tests

Select the TestCases folder or multiple test cases from the Navigator view and open the

context menu

by using rightclick. Select Play option. MarathonITE opens a Test Runner view and executes all

the

selected tests. You can select test to run from TestSuites, Features, Stories,

Issues views also.

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-ui.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-play.png)

Test Runner displays the elapsed time to run all the tests. Test runner’s progress bar that

displays the test

case count, error count and failure counts. The progress bar turns to red from green if any one

of the played scripts

fails.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-

progressbar.png)

The trace section of the test runner view displays the stacktrace of a failed test script. Select a

failed test script from

the test case tree view to see the corresponding stacktrace.

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-play.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-progressbar.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-failure.png)

When you run tests from the Test Runner, checklists are always accepted and

reports are always genearated.

Test Runner Actions

You can perform various actions using the test runner view toolbar.

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-failure.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-toolbar.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-toolbar.png)

The following table explains each of the actions in detail.

ACTION DESCRIPTION

Navigates to the next failure from the tests.

Navigates to the next previous from the tests.

Toggle between all tests and failed test (tree-view).

Re-run the previous run test.

Stops the currently running tests. Note that Marathon waits for the current test to

complete before aborting

the test run.

Runs the selected tests.

Generates and shows the report from current run.

Test Runner History

Test Runner allows you to save and manage test runs. Test Runner History is categorized into

two parts Unsaved History and Saved History (Favourites). Unsaved History are remove as count

exceeds Maximun Remembered Runs while saved history are saved forever and can be run

any time by selecting the test, it can also be run from

batch mode using name of the test (see section 3.8.3).

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-toolbar.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-manage.png)

Click on Manage History item from drop down menu. New window opens with list of

unsaved test run history as

show below.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-unsaved.png)

Unsaved History Actions

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-manage.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-unsaved.png


ACTION DESCRIPTION

Moves selected test run to favourites. It asks for a name, to save it

(test run) with.

Opens a window of saved test run (Favourites). On this window,

you can manage saved test runs which

is explained in below section.

Removes selected test run from the list.

Removes all test runs from the list.

Specifies the number of unsaved test runs to remeber.

Saved History Actions (Favorites)

(http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-saved.png)

ACTION DESCRIPTION

http://marathonite-userguide.com/wp-content/uploads/2019/02/testrunner-saved.png


Moves selected test run up.

Moves selected test run down.

Moves selected test run to unsaved history.

Removes selected test run from the list.

Removes all test runs from the list.

3.8.3. Executing Tests in Batch Mode

You can run tests using MarathonITE batch mode. The -batch option informs Marathon that

no UI is needed.

For running all tests from the project use the following command:

If no TestCase is given on command line, Marathon runs all the tests from the project directory.

If you want to run all tests

from a subfolder of TestCases directory you need to append AllTests to the folder name.

MarathonITE creates a marathon-reports folder in which the results of the tests are

written.

You can select only some tests to execute using various options of marathonite command.

COMMAND DESCRIPTION

Name of the test case(s). Usage: testname1 testname2.

+ Charatcter ‘+’ followed by name of the test suite. Usage: +suite_name

1 marathonite -batch [path-to-the-project-folder]

1 marathonite -batch [path-to-the-project-folder] [subfolder_name].AllTests



@ Charcter ‘@’ followed by name of the Feature. Usage: @feature_name

# Character ‘#’ followed by name of the Story. Usage: @story_name

! Character ‘!’ followed by name of the Issue. Usage: !issue_name

~ Character ‘~’ followed by name of the saved run. Usage: ~savedrunname

Some of the other commands available in batch mode.

COMMAND DESCRIPTION

-help Gives you the list of commands available.

-reportdir Path to report directory where test run report goes. Usage: -reportdir

torepor_dirt>

-capture Capture’s screen when error occurs.

-delay Delays a!er each statement execution Usage: -delay timein_ms>

-demo Runs AUT in demo mode. In this mode you can pause, delay or speed-up test(s)

exceution.

Running AUT in DEMO mode

You can use Marathon to execute your test application in DEMO mode using -demo command

line switch. MarathonITE displays a window. Using the controls in this window, you can change

the delay time between statements, pause the execution etc.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/batch-demo.png)

3.9. Organizing Tests

Organizing Tests

Marathonite allows you to oragnaize your test cases and lets you run the tests in many ways

which eases the test run.The

di"erent ways to organize test cases are listed below:

1. Folder heirarchy

The test scripts can be organized into regular folder structure. Each subfolder is considered

as

a separate container of tests. MarathonITE always lists the folders first, followed by the files

in alphabetical

order. This can be leveraged to number tests so that they can run in a particular order.

2. Features and stories

Following the Behaviour Driven methodology, the test scripts can be organized as Features

and

Stories. MarathonITE reports use this information to display test scripts by behaviour.

3. Suites

Multiple scripts, folders, features, issues or suites can be combined together to create a test

suite.

4. Link tests to Issues manager & TMS

When provided with a Test Management System and Issue Manager URL structure,

http://marathonite-userguide.com/wp-content/uploads/2019/02/batch-demo.png


MarathonITE allows you to visit the test information on a remote server.

The above types are explained in the following sections.

3.9.1. Organizing Tests in Folder Heirarchy

You can use the Navigator view of MarathonITE to manage your tests. You can organize your

test scripts using folders and sub-folders. While executing the tests, MarathonITE always

executes the tests under a subfolder first before executing the tests in the parent folder.

MarathonITE executes the test script in chronological order.

By judicial use of folder structure, you can ensure the order of execution of the tests. You can

execute a subset of tests by selecting them and choosing Play in the context menu. You can

also execute all the tests in a folder in this manner

(http://marathonite-userguide.com/wp-content/uploads/2019/02/FolderHeirarchy.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/FolderHeirarchy.png


3.9.2. Organizing Tests as Features and Stories

Behavior Driven Development is a so!ware development process that is used by some teams.

In BDD the unit of development is a Story. Multiple stories are grouped together as Features.

MarathoITE allows you to organize tests as features and stories. MarathonITE does not enforce

strict conditions and uses a feature or a story as grouping mechanism.

Working with Features

MarathonITE saves the feature information in a .feature file within Features folder in the

project. The feature file is saved in JSON format.

Creating Features

To create a new feature, select File->New->New Feature option from the menu.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Feature.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Feature.png


MarathonITE displays a popup window. Provide the name of the feature and click on OK.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Name_Feature.png)

MarathonITE creates the new feature and opens it in the editor. The editor displays two panes.

The le! pane displays all the tests that are available and the right pane contains the list of tests

added to the feature.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Features_Editor.png)

Drag and Drop the tests into the feature. You can rearrange the order of tests by using the Up

and Down buttons. Remove tests from the feature using Remove button.

Use Click button or Control+S (CMD+S on Mac) to save the feature.

Executing Features

http://marathonite-userguide.com/wp-content/uploads/2019/02/Name_Feature.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Features_Editor.png


To execute all the tests in a feature, select Play option from the context menu. MarathonITE

opens the Test Runner view and executes the tests.

Batch Running of Features

You can execute one or more features using MarathonITE batch mode.

Working with Stories

MarathonITE saves the story information in a .story file within Stories folder in the

project. The story file is saved in JSON format.

Creating Stories

To create a new story, select File->New->New Story option from the menu.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Story.png)

MarathonITE displays a popup window. Provide the name of the story and click on OK.

1 marathonite.bat -batch <Project Path> @feature1 @feature2...

http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Story.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Name_Story.png)

MarathonITE creates the new story and opens it in the editor. The editor displays two panes.

The le! pane displays all the tests that are available and the right pane contains the list of tests

added to the story.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Story_Editor-1024x306.png)

Drag and Drop the tests into the story. You can rearrange the order of tests by using the Up and

Down buttons. Remove tests from the story using Remove button.

Use Click button or Control+S (CMD+S on Mac) to save the story.

Executing Stories

To execute all the tests in a story, select Play option from the context menu. MarathonITE

opens the Test Runner view and executes the tests.

Batch Running of Stories

You can execute one or more stories using MarathonITE batch mode.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Name_Story.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Story_Editor-1024x306.png


Reports

MarathonITE uses allure reports to render the reports. When tests are organized as features

and stories, the Behaviors section of the report display the reports grouped by features and

stories.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Report-Showing-

Behaviours-1024x576.png)

3.9.3. Organizing Tests in Suites

You can organize tests in MarathonITE using Test Suite. A suite is a generic grouping

mechanism in MarathonITE. A suite can contain tests, features, stories, folders and also other

suites.

A suite can not include itself either directly or indirectly.

Working with Suites

1 marathonite.bat -batch <Project Path> #story1 #story2...

http://marathonite-userguide.com/wp-content/uploads/2019/02/Report-Showing-Behaviours-1024x576.png


MarathonITE stores the suite information in files with extension .suite in Suites folder.

The content is stored in JSON format.

Creating Suites

To create a new suite, select File->New->New Suite option from the menu.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Suite.png)

MarathonITE displays a popup window. Provide the name of the suite and click on OK.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Naming-a-Suite.png)

http://marathonite-userguide.com/wp-content/uploads/2019/02/Create_Suite.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Naming-a-Suite.png


MarathonITE creates the new suite and opens it in the editor. The editor displays two panes.

The le! pane displays all the tests, features, stories etc. that are available and the right pane

contains the list of tests added to the suite.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Suite-Editor-1024x447.png)

Drag and Drop the tests into the suite. You can rearrange the order of tests by using the Up and

Down buttons. Remove tests from the suite using Remove button.

Use Click button or Control+S (CMD+S on Mac) to save the suite.

Executing Suites

To execute all the tests in a suite, select Play option from the context menu. MarathonITE

opens the Test Runner view and executes the tests.

Batch Running of Suites

You can execute one or more features using MarathonITE batch mode.

Reports in Suites

MarathonITE doesn’t group the tests as suites in the reports because they are generic. Other

grouping mechanisms are used to display the test organization.

1 marathonite.bat -batch <Project Path> +suite1 +suite2...

http://marathonite-userguide.com/wp-content/uploads/2019/02/Suite-Editor-1024x447.png


3.9.4. Linking Tests to TMS and Issue Manager

You can link each of your tests to a test management system(TMS) like testlink or an issue

tracker like bugzilla. Once setup you will be able to open the link to your TMS or Issue tracker

from within the editor. The reports also provide hyperlinks to the issue tracker or TMS.

Specifying the Links

Open the project settings from Marathon->Project Settings... menu item. In the

Issue Tracker pattern provide the web address of the Issue Tracker. A %s in the pattern is

replaced by the Issue ID from the test properties. Similarly, provide a pattern for the TMS

system.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Setting-TMS-and-Issue-

Tracker-Patterns-1024x675.png)

Setting Issue ID and TMS ID to a Test

Select the Properties menu item from the context menu of a test.

In the Add Property window , enter the id and click on OK. You can create a new Issue or

add the test script to the existing issues from the property window.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Setting-TMS-and-Issue-Tracker-Patterns-1024x675.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Updating-Test-Properties-

1024x646.png)

Visiting TMS and Issue Tracker

When a TMS/Issue pattern is provided and a test case is linked to a TMS or a Issue tracker – in

the editor window MarathonITE shows a dropdown button. You can click on a Issue ID or TMD

ID from the drop down. MarathonITE launches the default browser and the item details are

displayed.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Updating-Test-Properties-1024x646.png
http://marathonite-userguide.com/wp-content/uploads/2019/02/Visiting-TMS-and-Issue-Tracker-from-Editor-1024x505.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Visiting-TMS-and-Issue-

Tracker-from-Editor-1024x505.png)

3.10. Modularizing Test Scripts

Marathon supports modules – set of methods that can be called from within a test script.

Modules improve reusability of script,

since a single module method can be used in multiple places. Marathon modules are regular

ruby script files with a set

of methods. The di"erence between regular ruby modules and Marathon modules is that you

can insert a Marathon module

method while recording a script.

Using Marathon you can create templates for a module method and save them. MarathonITE

provides an Extract Module refactoring

using which you can easily create a module method.

In this chapter a!er a quick look at advantages of refactoring scripts you will see how you can

create modules in Marathon.

Why Modularizing?

Modularizing is the act of splitting a test script into methods. Using methods in a test script

makes it easier

to read and understand it. Methods also allow you to avoid duplication and the insert script

Marathon action while recording,

allows you to reuse the methods even while recording a test script.

There are many valid reasons for creating a method. Let us enumerate some of them here.

1. Reducing complexity

http://marathonite-userguide.com/wp-content/uploads/2019/02/Visiting-TMS-and-Issue-Tracker-from-Editor-1024x505.png


You need to think about what is inside a method while developing or changing the method

itself, but once a method is written

you just use it.

2. Avoiding duplicate code

By extracting the code into a common method (may be with some parameters) you can avoid

duplication.

3. Isolate changes

Suppose you have a dialog where you enter user details. What happens when the dialog is

changed? If the enter user details

operation is in a method even though it may have been used hundreds of times – you need to

modify only a single method.

4. Isolating operations on custom components

There comes a time when you need to support a custom component in your test project.

Fortunately, Marathon facilitates accessing

the underlying Java component. You can access that component and perform the operations.

But what happens when you need

to do this in a lot of test scripts? Pull that part of code as a module method and you can use

insert script command

to perform all the jugglery.

5. Script readability

It’s easier to understand when a certain code is extracted to a method rather than going

through all the code.

3.10.1. Module Methods

Marathon modules are regular ruby modules – except that Marathon interprets them to

provide access to them during recording



scripts. Each module is a script file within a module folder. Each file can contain one or more

methods.

A test project can have multiple Modules folders. When you create a project, Marathon creates

a default

module folder Modules. The Modules folder is added to the language runtime path, so that

you can access

these files from the test scripts.

Creating Module Folder

For creating a module folder use File --> New --> New Module Directory,

Marathon opens a New Module Directory dialog.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/module-dir.png)

Creating submodules

Use Navigator view to create a folder. These folders will be avilable as submodules in insert

script command.

Creating Module Function

Module Files : A module file is a script file with one or more methods. Marathon interprets

these methods.

A method can have default values for parameters. When inserting, these default values are

shown in the Insert Script dialog. If the default parameter is a list, then Marathon displays

true/false combo box.

Creating Module Method

http://marathonite-userguide.com/wp-content/uploads/2019/02/module-dir.png


Using File --> New --> New Module command you can create a templet for a module

method. When you select

this option, Marathon opens a New Module Function dialog.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/new-module-function.png)

Module function name : Enter a name for the module method. This should be a valid method

name according

to the script syntax.

Description : Enter a description for the module method. This will be written into the module

file and also

displayed when insert script command is executed.

Module Directory : From the drop-down list, select a module directory.

Module File : You can select the name of an existing module file or enter a new module file

name here. If

the file already exists, Marathon appends the method template to the module file.

Click OK to save the method template. Marathon saves the template into the file given and

positions the

cursor inside the method.

http://marathonite-userguide.com/wp-content/uploads/2019/02/new-module-function.png


3.10.2. Extract Method Refactoring

Refactoring is a technique for restructuring an existing body of code, altering its internal

structure without changing its external behavior. Extract Method is an important refactoring.

Extracting a method improves readability of your test script and improves reusability.

MarathonITE supports extract method refactoring. Using this option you can create module

methods.

Performing an Extract Method Refactoring

We will use the following script to demonstrate the use of extract method refactoring.

Orginal Script

You can select the code you want to extract into a module method and click on the Extract

Module menu item in the tool bar.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Toolbar-

Button.png)

MarathonITE displays Extract a Module Function dialog.

1
2
3
4
5
6
7
8
9
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11
12
13
14
15
16

 
#{{{ Marathon
require_fixture 'default'
#}}} Marathon
 
def test
    with_window("Simple Widgets") {
        select("Name", "Johny")
        select("Password", "Yes Papa")
        select("country", "USA")
        select("Male", "true")
        select("English", "true")
        select("French", "true")
    } 
end
 

http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Toolbar-Button.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Dialog.png)

The option Extract allows you to extract the method and place it in the same test script.

When you use the Extract to Module option, you can place it into an external module file

and the method can be reused in other scripts.

Identifying the Parameters

The window displays the selected code in the upper pane. The lower pane displays the

costants and variables that are used in the selected line of code. Click on the checkbox to

select the variables that are to be extracted as method parameters. You can change the

paramter name by modifying the Extract with name column of the table.

Extract code into a method

Click on the Extract button.

MarathonITE displays a Method Details dialog.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Dialog.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Method-

Details.png)

Enter a name for the method and optionally enter the description. Click on OK to perform the

refactoring.

Test Script

Extract a Module Method

When you click on the Extract to Module, MarathonITE opens the Module Method Details

dialog.
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#{{{ Marathon
require_fixture 'default'
#}}} Marathon
 
def test
    set_widget_values()
end
 
=begin
Setting up the widget values in the Sample Widget window
=end
def set_widget_values()
  
  with_window("Simple Widgets"){
    select("Name", "Johny")
    select("Password", "Yes Papa")
    select("country", "USA")
    select("Male", "true")
    select("English", "true")
    select("French", "true")
  }
end
 

http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Method-Details.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Method-

Details.png)

Enter the module method name. Optionally add a description to the method. From the

module directory dropdown select a module folder. In the module file field – either select an

existing file or enter a new file name.

Click OK. MarathonITE extracts the method into the given file and places it in the Modules

folder. The existing script is refactored to use the extracted method.

While recording, you can use insert script command to reuse a module method.

3.10.3. Using Data Loops

You can use MarathonITE‘s data loops when you need to perform same operations multiple

times. For example, if one of your test scripts is required to create 100 accounts – use a

dataloop to perform the account creation steps.

You can use MarathonITE‘s Create Data Loop refactoring to quickly convert a regular test script

to a data driven one. MarahtonITE also includes a CSV Editor to quickly create or modify data.

Looping Through Data

http://marathonite-userguide.com/wp-content/uploads/2019/02/Extract-Module-Method-Details.png


You can loop through the data from a file using Marathon’s with_data method. The data file

is expected to be in CSV format. The file should be placed in TestData folder. For each row of

data MarathonITE executes the given block of code. Each of the data values is set as a global

variable using the name given in the header.

Example Data Loop.

You access each datum using the name provided to the column in the header.

3.10.4. Convert to Data Loop Refactoring

You can use the Convert to Data Loop refactoring to quickly convert a normal test script to use

data from a CSV file.

Convert to Data Loop Refactoring

Select the code you want to create a loop for and click on the create data loop button or

clicking on menu item Refactor --> Create Data Loop. Marathon displays Create

Data Loop dialog.

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

 
#{{{ Marathon
require_fixture 'sample'
#}}} Marathon
def test
    $java_recorded_version = "1.6.0_24"
    with_window("Simple Widgets") {
        with_data ('sample.csv') {
            select("Name", $name)
            select("Password", $password)
            assert_p ("Name", "Text", $check_name)
    } 
}
end
 



(http://marathonite-userguide.com/wp-content/uploads/2019/02/Convert-to-Data-Loop-

Dialog.png)

Select a line of code in the selected script. The below pane displays the constants that can be

extracted. Use the checkboxes to select the items that need to be accessed from the data file.

You can change the name of a variable by modifying the Extract with name column.

Click on OK buutton. MarathonITE prompts for a file name for the data file.

http://marathonite-userguide.com/wp-content/uploads/2019/02/Convert-to-Data-Loop-Dialog.png


(http://marathonite-userguide.com/wp-content/uploads/2019/02/Save-CSV-File.png)

Provide a file name and click OK. Marathon currently supports CSV files only. You can edit csv

file using CSV editor to add di"erent values.

Marathon saves the first row in the data file and also will update the script to use the data

driven loop.When the test case is played Marathon runs the test case with data in the csv file.

3.11. Data Driven Tests

Data Driven testing (DDT) is creation of test scripts where the input as well as results are

accepted from

an external data source. In the simplest form the tester supplies the inputs from a row in the

http://marathonite-userguide.com/wp-content/uploads/2019/02/Save-CSV-File.png


table and expects the

outputs which occur in the same row. In the context of Marathon, the input is the values that

you set to the components

and the expected results are what you provide in the assert methods.

MarathonITE also provides you a way to create a loop that is data driven. This is especially

useful when you need to perform same set of operations multiple times such as

creating a set of accounts.

MarathonITE‘s data driven framework has Create DDT and Create Data Loop refactorings that

simplify creation of data driven tests. It also includes a CSV file editor for quick creation of

data.

Marathon CSV Editor

(http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor-1.png)

Testing with External Data

In data driven testing, you provide the data from an external source. Marathon supports CSV

format files for accessing

the data. The header in the CSV file provides the variable names used in the test and each

subsequent row contains the

data for each test run or loop. The advantage of data driven testing is that you can add

additional inputs to the data

http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor-1.png


file for di"erent cases without touching the test script. This segregation of test control and test

data improves the

maintainability of the test project.

Marathon Data Driven Tests

Marathon data driven tests are regular test scripts with a magic marker in the form of

usedatafile

in the test header. The usedatafile also provides the name of the test data file that contains the

data. The data file has a header row that defines variable names and subsequent rows with the

data. When Marathon encounters

a data driven test – recognized by the usedatafile marker – it considers this test as a suite of

tests

with one test for each row in the data file. Marathon also reads the file and defines a global

variable for each data

column and assigns it with the value from the data column of the current row. If the first

column name is marathontestname

the name is appended to the test script name to create individual test names.



(http://marathonite-userguide.com/wp-content/uploads/2019/02/ddt-testrunner.png)

3.11.1. Convert to DDT Refactoring

Open the test case and open the Create Data Driven Test dialog by using «Refactor» ? «Create

DDT…» command or

toolbar button .

We will start with an example (recorded using SwingSet3 application):

#### Original Code

1 #{{{ Marathon

http://marathonite-userguide.com/wp-content/uploads/2019/02/ddt-testrunner.png


From the script we will extract string “John” using Create Data Driven Test dialog, as show

below.

(http://marathonite-userguide.com/wp-content/uploads/2019/02/ddt-extract-dialog.png)

Select a line in Script Selection section from which you have to extract. All the

Constants, which can be extracted

will be shown in table-view Constants. You have to select corresponding checkbox(es) of

2
3
4
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6
7
8
9
10
11
12
13
14
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    require_fixture 'default'
    #}}} Marathon
    
    severity("normal")
    
    def test
    
        with_window("SwingSet3") {
            select("JButton", "true")
            select("tfHistory", "John")
            assert_p("tfHistory", "Text", "John")
        }
    
    end

http://marathonite-userguide.com/wp-content/uploads/2019/02/ddt-extract-dialog.png


the value column(s)

to extract as parameter(s). You can also edit the name of the parameter in Extract

with name column by double clicking on it.

All the extracted parameters are listed on Module Parameters section. Once extraction is

done, press Convert button, it prompts for a file name to save it with. It create a CSV file with

data(s) and save it in TestData

folder.

#### Converted Code

The extract refactoring adds the call to use_data_file in the header. The file is expected to

be in TestData

folder. Note the $ prefix to variable names. These are global in nature.

Executing Data Driven Tests

There are mutiple ways of executing Data Driven Test. You can run the tests in regular way from

Marathon as well as command line. Click on the play button to run

the test. Observe that the test runs once for the data row.

Managing Data

We can add more data to the CSV file. Edit the CSV file using CSV Editorand add few more

rows. To open

CSV Editor, doulbe click on a CSV file which is under TestData folder.

1
2
3
4
5
6
7
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13
14
15
16

#{{{ Marathon
    require_fixture 'default'
    use_data_file('name-data.csv')
    #}}} Marathon
    
    severity("normal")
    
    def test
    
        with_window("SwingSet3") {
            select("JButton", "true")
            select("tfHistory", $name)
            assert_p("tfHistory", "Text", $name)
        }
    
    end



(http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor_2.png)

Select a row from the table-view and copy the row using button . Then edit columns to

add data. The first column i.e marathontestname is appended

to the test script name to create individual test names. Select a row and click button  to

remove data from file.

4. Advanced Scripting

Currently Marathon and MarathonITE support ruby scripting language for recording scripts.

You can use any ruby gems

(supported by JRuby) within your scripts to perform custom operations.

Internally, Marathon uses Selenium/WebDriver bindings to record and replay test scripts on

Java applications. For this purpose,

Marathon includes JavaDriver – Selenium/WebDriver for Java applications. Since, Marathon

uses Selenium bindings, you

can also use selenium/webdriver ruby bindings in your scripts. JavaDriver implements a

subset of findBy strategies that can be used to access components on the UI.

http://marathonite-userguide.com/wp-content/uploads/2019/02/csv-editor_2.png


4.1. Ruby Programming Language

JRuby – not Ruby

Though Marathon refers to the scripting as ruby it is actually uses JRuby (http://jruby.org/) – a

Java implementation

of ruby. Your Marathon or MarathonITE installation contains a copy of JRuby included.

Ruby Console

Run mirb to invoke JRuby console or mruby to invoke JRuby from Marathon installation

folder.

Ruby Basics

In this section we will quickly walk through the basics of Ruby as a programming language.

Variables

There are 4 di"erent types of variables you will come across in Ruby.

Constants

Ruby constants begin with an uppercase letter. All Java class names are considered as

constants in

JRuby.

Example Constants.

Var1 = 100. The variable Var1 is a constant.

System.getProperty('java.version') or

System.get_property('java.version'). In this statement System is a Java

class and also a JRuby constant.

Local Variables

Local variables begin with a lowercase letter or _. The scope of a local variable ranges from

beginning of a block (class, module, def) till the end of that block.

http://jruby.org/


Golbal Variables

Global variables begin with $. It is best to avoid global variables. Marathon uses

global variables for data driven testing.

Example Global Variables.

setnamepassword($name, $password).

When using data driven testing, each record from the data file is read and each column

value is set to a global variable

(whose name is in the header row of that column).

Ruby Instance and Class variables

Instance variables begin with @ and Ruby class variables begin with @@.

Ruby Special Variables

A set of special variables are defined by Ruby – these might appear as local variables – but you

cannot write into these

variables.

self – The current object.

true – Value representing true boolean value.

false – Value representing false boolean value

nil – Value representing undefined or uninitialized.

__FILE__ – The name of the current source file (string)

__LINE__ – The current line number (integer)

Strings

Ruby strings are enclosed in single quote or double quote characters. A string delimiter within

a string can be escaped using

the backslash character. Ruby strings are powerful. You can substitute the value of any ruby



expression into a string

using #{ and } delimeters.

Ruby String Examples.

The output from the above snippet will be:

Methods

Ruby methods are used to extract repeated set of statements into a single unit. Method names

should begin with a lowercase

letter.

Method without any arguments.

Method with arguments.

Method with arguments and default values.

Default values can only be omitted for the last set of arguments.

Conditionals

1
2
3
4
5

puts 'This is a string literal'
puts "This is also a string literal"
puts "Escape " with a ";
i,j = 10, 20
puts "You can substitute the value of any ruby expression as #{i+j}"

1
2
3
4

This is a string literal
This is also a string literal
Escape " with a 
You can substitute the value of any ruby expression as 30 

1
2
3
4
5

def method_name
expressions
...
...
end

1
2
3
4
5

def method_name(arg1, arg2)
expressions
...
...
end

1
2
3
4
5

def method_name(arg1 = 'hello', arg2 = 10, arg3)
expressions
...
...
end



Ruby provides if/else, unless/else and case conditional statements.

Example if…else statement.

Output.

You can also use an if modifier at tail end of code that is to be executed if the condition is true.

Example if modifier.

Output.

I shall always print

The unless statement is reverse of if. The body is executed only when the conditional is false.

unless can also be su"ixed to code.

Example unless statement.

Output.

You can also use the case statement for reducing the number of if…else branches where

appropriate.

1
2
3
4
5
6
7
8

x = 1
if x > 2
 puts "x is greater than 2"
elsif x <= 2 and x != 0
 puts "x is 1"
else
 puts "What a number"
end

1 x is 1

1 puts "I shall always print" if true

1
2
3
4
5
6
7
8

x = 1
unless x == 1
 puts "x is not equals to 1"
else
 puts "x is equal to 1"
end
 
puts "x is equal to 1" unless x != 1

1
2

x is equal to 1
x is equal to 1



Example case statement.

Output.

Note the use of inclusive range operator ..(double dots). Ruby also has an exclusive range

operator ...(triple dots)

Loops

Loops and iterators are used to execute the same block of code multiple times. In a loop, a

condition controls the number

of times a loop is executed, whereas you use an iterator to perform an action for each of the

elements in the container.

A while statement executes the given block of code till a given conditional becomes false.

while statement example.

Output.

1
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3
4
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age = 2
case age
when 0 .. 2
 puts "baby"
when 3 .. 6
 puts "little child"
when 7 .. 12
 puts "child"
when 13 .. 18
 puts "youth"
else
 puts "adult"
end

1
2
3

 
baby
 

1
2
3
4
5

i = 0
while i < 4 do
 puts "Inside the loop. Value of i = #{i}"
 i += 1
end

1
2
3
4

Inside the loop. Value of i = 0
Inside the loop. Value of i = 1
Inside the loop. Value of i = 2
Inside the loop. Value of i = 3



The while keyword can also be used as a modifier at the end of a block of code. The loop body

is executed at least

once in this case.

while modifier example.

Output.

The while modifier can also be used on a single line as follows:

while modifier single line example.

Output.

until statement is complementary to the while statement. The loop is executed till the given

conditional

becomes true.

until statement example.

Output.

1
2
3
4
5

i = 0
begin
 puts "Inside the loop. Value of i = #{i}"
 i += 1
end while i < 3

1
2
3

Inside the loop. Value of i = 0
Inside the loop. Value of i = 1
Inside the loop. Value of i = 2

1
2
3
4
5
6
7

def loop_body
 puts "Loopbody: #{$i}"
 $i += 1
end
 
$i = 0
loop_body while $i < 2

1
2

Loopbody: 0
Loopbody: 1

1
2
3
4
5

i = 0
until i >= 4 do
 puts "Inside the loop. Value of i = #{i}"
 i += 1
end

1
2

Inside the loop. Value of i = 0
Inside the loop. Value of i = 1



until can also be used as a modifier and given at the end of a code block.

until modifier example.

Output.

A for statement executes code once for each element in an expression.

for statement example.

Output.

A loop can be terminated prematurely by using the break statement.

break example.

Output.

You can skip processing the current iteration of a loop and go to the next iteration by using

next statement.

3
4

Inside the loop. Value of i = 2
Inside the loop. Value of i = 3

1
2
3
4
5
6
7

def loop_body
   puts "Loopbody: #{$i}"
   $i += 1
end
 
$i = 0
loop_body until $i >= 2

1
2

Loopbody: 0
Loopbody: 1

1
2
3

for i in 0..2
 puts "Value of i = #{i}"
end

1
2
3

Value of i = 0
Value of i = 1
Value of i = 2

1
2
3
4

for i in 0..2
 puts "Value of i = #{i}"
 break if i == 1
end

1
2

Value of i = 0
Value of i = 1



next example.

Output.

Arrays

Ruby arrays are ordered, integer indexed collections of heterogeneous objects. Each element

of an array is accessed using an integer index. Array indexing starts at 0.

Example Array and Iteration.

Output.

Hashes (or Maps)

A Hash is a collection of key/value pairs. Hash indexing is done by arbitrary keys of any type.

Example Hash and usage.

Output.

Note that the months.keys returns an Array.

Iterators

1
2
3
4

for i in 0..2
 next if i == 1
 puts "Value of i = #{i}"
end

1
2

Value of i = 0
Value of i = 2

1
2

a = [1,2,3]
a.each { |i| puts i * 2 }

1
2
3

2
4
6

1
2
3

months = { 1 => "Jan", 2 => "Feb" }
puts months[1]
puts months.keys

1
2

Jan
[1, 2]



Iterators are methods that perform an action on each element of a collection. each method

performs a body

of code for each element of the collection.

each Example.

Output.

Using each on a Hash gives each element as an array containing the key and value.

each Example with Hash.

Output.

You can use collect method to transform a collection.

collect Example.

Output.

collect can also be used on a Hash.

collect Example with a Hash.

1
2

a = [1, 2, 3]
a.each { |i| puts i * 2 }

1
2
3

2
4
6

1
2

a = { 1 => "One", 2 => "Two", 3 => "Three" }
a.each { |k, v| puts "#{v} = #{k}" }

1
2
3

One = 1
Two = 2
Three = 3

1
2
3

a = [1, 2, 3]
b = a.collect { |i| i * 2 }
puts b

1
2
3

2
4
6

1
2
3
4

a = { 1 => "One", 2 => "Two", 3 => "Three" }
b = a.collect {
  |k, v|
  if k % 2 == 1



Output.

You can find an element that confirms to a certain criteria using the find method.

find Example.

Output.

The find method returns only the first element. Use find_all method to find all elements.

find_all Example.

Output.

Java Access

You can access Java objects from JRuby scripts. This is very useful in Marathon scripts because

you can access any Java API to perform operations. One example of this is

accessing excel sheets using apache POI library. You can create new objects of these classes

using regular Ruby syntax.

Creating a new Java Object.

5
6
7
8
9
10

    "#{v} is Odd";
  else
    "#{v} is Even"
  end
}
puts b.inspect

1 ["One is Odd", "Two is Even", "Three is Odd"]

1
2

a = [1, 2, 3]
puts a.find { |i| i % 2 == 1 }

1 1

1
2
3

a = [1, 2, 3]
b = a.find_all { |i| i % 2 == 1 }
puts b.inspect

1 [1, 3]

1
2
3
4
5
6
7
8

# Use "include_class" statement to make JRuby runtime aware of the class
include_class 'java.util.Properties'
 
# Use "new" method on the class to create a new object
props = Properties.new
 
include_class 'javax.swing.JFrame'
 



Accessing Object properties.

Once you create a Java object you can call methods and access properties of the object using

regular ruby operations.

4.2. Marathon and Ruby

In this section we will look at an example Marathon test script.

This is a modified script a!er a bit of refactoring and renaming.

An annotated Marathon script.

9
10

# You can also pass parameters to constructors.
frame = JFrame.new 'My Frame'

1
2
3
4
5
6
7
8

# Calls JFrame#setTitle method
frame.title = "My Frame"
 
frame.visible = true
 
# getXXX can be called using just XXX
frame.size # calls frame.getSize()
frame.width = 100 # calls frame.setWidth()

1
2
3
4
5
6
7
8
9
10
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15
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20
21
22
23
24
25

# Marathon adds this monikers while recording a script. Usually you do not
# modify any code within these monikers.
#
# The "require_fixture" defines the fixture to be used for this test script.
#
# The "require" statement is importing widgets module.
#
# The "use_data_file" statement defines that this test is a data driven test
# and test data should be available in "firsttest.csv" file.
 
#{{{ Marathon
require_fixture 'default'
require 'widgets'
use_data_file('firsttest.csv')
#}}} Marathon
 
# Each Marathon test script has a test method. When Marathon executes a test
# script, it expects a "test" method to be defined in the script.
 
def test
    # The "with_window" method executes the attached block when the given window is opened.
    with_window("Simple Widgets") {
        # The "set_name_password" method is a module method - presumably defined in "widgets" module.
        set_name_password($name, $password)
        # Marathon records the state of an object using "select" calls.



Let us also look at a Marathon module script.

An annotated Marathon Module script.

get_component

get_component is a Marathon addition that returns the WebElement identified by the

name. You can perform operations on a WebElement by using the execute_script

method.

execute_script

execute_script method allows you to execute arbitrary Java code. You can pass

WebElement and other parameter objects which are converted to corresponding Java

components. You can access positional parameters using $1, $2 etc.

You can return values using return statement in the code block. You can return, Java

components, integers, strings, boolean etc. You can’t return built-in types like int, float etc.

Convert them first using boxing operations like Integer.valueOf.

If you want to access a Java class (except for classes in java.lang package), you need to use

fully classified names. For eg. use javax.swing.JTable.

The following examples show how it can be done.

Example – 1

26
27
28
29
30

        select("email", $email)
        select("address", $address)
        select("country", $country)
    }
end

1
2
3
4
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15
16
17
18

# The comment at the beginning of the method is displayed when you select insert script
# command while recording.
 
=begin
Sets name and password.
=end
 
# The insert script dialog uses these default values to fill in the fields. If a default
# value is a list or a boolean value (true/false) - the dialog displays a drop down list.
def set_name_password( name = "Marathon", password = "Secret")
    # The "with_window" call in a Module method is important. The insert script dialog
    # allows you to filter only those methods that are available for the current window
    # by using the parameter of this call.
    with_window("Simple Widgets") {
        select("First Name", name)
        select("Password", password)
    }
end



Example – 2

4.3. Selenium/WebDriver Bindings

MarathonITE provides access to Selenium/WebDriver bindings to your scripts. This

extends

Selenium/WebDriver bindings for Ruby. When you access a component in MarathonITE

using

get_component, the object you receive is a WebElement. You can perform any of the

standard WebDriver operations on this WebElement. You can use any

Selenium/WebDriver

calls and intersperse them with MarathonITE calls. This provides your scripts the power and

flexibility they may need for implementing complex scenarios.

MarathonITE Java Drivers implement Selenium JSON Wire Protocol

MarathonITE uses marathon java drivers. The drivers implement Selenium/WebDriver

JSONWireProtocol (https://github.com/SeleniumHQ/selenium/wiki/JsonWireProtocol) – the

protocol used

by WebDriver instances to communicate with browsers. Marathon JavaDriver implements the

protocol and enhances

it to work with Java/Swing™ and Java/FX™ applications. Testers who are familiar with

1
2

table = get_component('some_table_name')
puts "Row count = #{driver.execute_script('return Integer.valueOf($1.getRowCount());', table)}"

1
2
3
4
5
6
7
8
9
10
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search_item = 'Jon'
find_and_select_item_element_java = %{
  javax.swing.ComboBoxModel model = $1.getModel();
  for(int i = 0; i < model.getSize(); i++) {
    if(model.getElementAt(i).equals("#{search_item}")) {
      $1.setSelectedItem(model.getElementAt(i));
      break;
    }
  }
}
driver.execute_script(find_and_select_item_element_java, get_component('some_combobox_name'

https://github.com/SeleniumHQ/selenium/wiki/JsonWireProtocol


Selenium/WebDriver can take advantage of this integration. For Web applications,

MarathonITE uses

standard Selenium drivers with enhancements for recording functionality.

Selenium/WebDriver Commands and Operations

Finding Elements

Finding elements in JavaDriver can be done on the JavaDriver i.e driver instance itself or on

a

WebElement. The java driver instance is available as driver within the script. You

can use find_element and find_elements methods to access the components. The

former

returns a WebElement object matching the selector, and throws an exception if such an

element

cannot be found. The latter returns a list of WebElements, possibly empty if no elements

match

the selector.

The find_element(s) methods take selector. Di"erent kinds of selector available are list

below

By ClassName

ClassName in this case refers to fully qualified class names of Java/Swing Components

or Java/FX Controls.

Example:

To find JTable (whose fully qualified class name is javax.swing.JTable) using

ClassName, you can use following code in your script:

By TagName

A tagname is computed by finding the Swing/AWT or Java/FX superclass of the component or

control and converting CamelCase to camel-case.

1
2
3

table = driver.find_element(:class_name, 'javax.swing.JTable')
# To find all the tables
tables = driver.find_elements(:class_name, 'javax.swing.JTable')



Example:

To find JTextField (whose computed tag name will be text-field) using TagName, you

can use following code in your script

By Name

A name in this case refers to attribute that is set through, for Java/Swing

java.awt.Component#setName and for Java/FX javafx.scene.Node#setId

method.

Example:

To find JList (whose name is “Places”) using Name, you can use following code in your script

By CSS

CSS here refers to attributes or properties of components (like name, id, rowCount,

orientation etc.). You can use :pseudoclass, ::pseduoelement as a CSS selector.

Examples:

To find JList (whose name is “Places”) using css, you can use following code in your script

To find JCheckBox using pseudoclass as css selector

To find JList‘s nth-item using pseudoelement as css selector

Getting attributes

You can get Java/Swing Component’s or Java/FX Control’s attribute using WebElement’s

attribute method. It always returns string value. Any property which is visible can be

retrieved through attribute method.

1 text_field = driver.find_element(:tag_name, 'text-field')

1 list = driver.find_element(:name, 'Places')

1 list = driver.find_element(:css, 'list[name = "Places"]')

1 check_box = driver.find_element(:css, 'check-box:selected')

1 nth_item = driver.find_element(:css, 'list::nth-item(3)')



Example:

To retrieve attribute starting with get. To get JList#getRowCount property use below

code. (i.e getPropertyName => propertName)

To retrieve attribute starting with is. To get JCheckBox#isSelecetd property use

below code. (i.e isPropertyName => propertName)

To retrieve attribute starting with has. To get JTable#hasFocus property use below

code. (i.e hasPropertyName => propertName)

To retrieve attribute i.e x.y. To get JList#getSelectedIndices#getSize

property use below code. (i.e getPropertyName1.getPropertyName2 =>

propertName1.propertyName2)

It also applies for attribute i.e x.y.z.

To retrieve attribute that does not starts with get, is and has. To get some property use

below code. (i.e propertyName => propertName)

User Input

MarathonITE itself internally uses WebDriver calls to implement script elements like

select and click.

Example:

MarathonIte records text-field input with its naming property and text value, as

1
2

list = driver.find_element(:tag_name, 'list')
list.attribute("rowCount")

1
2

check_box = driver.find_element(:tag_name, 'check-box')
check_box.attribute("selected")

1
2

table = driver.find_element(:tag_name, 'table')
table.attribute("focus")

1
2

list = driver.find_element(:tag_name, 'list')
list.attribute("selectedIndices.size")

1
2

table = driver.find_element(:tag_name, "table")
table.attribute("someProperty")

1  



Similarly you can use WebDriver‘s send_keys method to fill text-field

Moving Between Windows

Some applications have multiple windows. JavaDriver supports moving between windows

using the “switchTo” method as in WebDriver:

Alternatively, you can pass a “window handle” to the switchTo().window() method.

Knowing this, it’s possible to iterate over every open window like so:

Drag and Drop

Here’s an example of using the Actions class to perform a drag and drop.

ruby

list_item_1 = driver.find_element(:css, "list::nth-item(1)")

list_item_2 = driver.find_element(:css, "list::nth-item(5)")

driver.action.drag_and_drop(list_item_1, list_item_2).perform

Explicit Waits

An explicit wait is code you define to wait for a certain condition to occur before proceeding

further in the code. Below is an example of using Explicit Wait to wait for check-box to

selected.

Taking a Screenshot

Here’s a example of using JavaDriver to take screenshot

2
3

select("text-field", "value")
 

1
2

tf = driver.find_element(:tag_name, "text-field")
tf.send_keys("HelloWorld")

1 driver.switch_to.window("windowNameORwindowTitleOrwindowHandle")

1
2
3

driver.window_handles.each do |handle|
    driver.switch_to.window handle
end

1
2
3
4
5

check_box = driver.find_element(:tag_name, "check-box")
wait = Selenium::WebDriver::Wait.new(:timeout => 10) # seconds
begin
  wait.until { check_box.attribute("selected") == "true" }
end

1 driver.save_screenshot("path_to_img_file")



4.3.1. Java/Swing™ Components

MarathonITE implements a CSS finder for Java applications. You can use WebDriver’s

find_element(s) call to quickly find a component in the application.

Under this section, we will go through di"erent kinds of selectors that are available.

Simple Selectors

Some of the simple selectors are tagname, * (all), . (self).

SELECTOR DESCRIPTION EXAMPLE

tagname Selects an element with the given

tagname. A tagname is computed by

finding the Swing/AWT superclass of

the component and converting

CamelCase to camel-case.

JSpinner -> spinner,

JTextField -> text-field

*

Universal

Gets all the elements. It retuns list of

elements.

driver.find_elements(:css,

"*")

. Self It returns the same element.
tree =

driver.find_element(:css,

"tree")

tree_1 =

tree.find_element(:css,

".")

tree and tree_1 are same.

#name Select a component with the given If component has name : (set through



name. java.awt.Component#setName

method), you find component using

#component_name.

Above listed selectors can be used on all components.

Other Selectors

SELECTOR DESCRIPTION EXAMPLE

[attribute

value]

Find components with the given

value for the attribute. The

operation can be *= (contains),

/= (regex match), = (equals), ^=

(startswith), $= (endswith).

button[text="Click Me!!"].

This selector finds all the buttons

whose text is equal to “Click Me!!”

:: Find components for which

returns true. Pseudoclasses

avaiable are selected,

enabled, displayed,

hidden and instance-

of("").

text-field:enabled. This

selector finds all the text-fields

which are enabled.

::

PseudoElements:

This selector finds the pseudo

elements.

driver.find_elements(:css,

"combo-box::all-options")

Operations on components

Below is the list of components and the selectors that can be used for it, with examples

JButton

Using [attribute value]

1 button = driver.find_element(:css, "button[text = 'Click Me!!']")



Using

JComboBox

Using [attribute value]

Using

Using : Available pseudoelements are nth-option(index) and all-options.

JList

Using [attribute value]

ruby

list = driver.find_element(:css, "list[name ^= "Places"]")

Using

Using : Available pseudoelements are nth-item(index) and all-items.

1
2
3
4

button = driver.find_element(:css, "button:enabled")
# or using self selector
button = driver.find_element(:css, "button")
button.find_element(:css, ".:enabled")

1 combo_box = driver.find_element(:css, "combo-box[name ^= 'Place']")

1
2
3
4

combo_box = driver.find_element(:css, "combo-box:hidden")
# or using self selector
combo_box = driver.find_element(:css, "combo-box")
combo_box.find_element(:css, ".:hidden")

1
2
3
4
5
6
7
8

# Returns 2nd option from the combo-box
driver.find_element(:css, 'combo-box::nth-option(2)')
# OR
combo_box = driver.find_element(:tag_name, 'combo-box')
combo_box.find_element(:css, '.::nth-option(2)')
 
#Returns list of all the options from the combo-box
driver.find_elements(:css, 'combo-box::all-options')

1
2
3
4

list = driver.find_element(:css, "list:displayed")
# or using self selector
list = driver.find_element(:css, "list")
list.find_element(:css, ".:displayed")

1
2
3
4
5
6
7

# Returns 4th item from the list
driver.find_element(:css, 'list::nth-item(4)')
# OR
list = driver.find_element(:tag_name, "list")
list.find_element(:css, ".::nth-item(4)")
 
#Returns list of all the options from the combo-box



JEditorPane

Using [attribute value]

Using

Using : Available pseudoelements are tag(name), where name can be a, ol, ul etc.

ruby

editor = driver.find_element(:css, "editor-pane")

editor.find_element(:css, ".::tag('a')[text='Title Page']"));

JTabbedPane

Using [attribute value]

Using : Available pseudoelements are nth-tab(index), all-tabs and selected-tab.

JTableHeader

Using : Available pseudoelements are nth-item(index) and all-items.

JTable

Using [attribute value]

Using : Available pseudoelements are header, mnth-cell(row, column), all-cells

and mnth-cell-editor(row, column).

8 driver.find_elements(:css, "list::all-items")

1 editor_pane = driver.find_element(:css, "editor-pane[name $= 'Pane'])

1
2
3
4

editor_pane = driver.find_element(:css, 'editor-pane:displayed')
# OR using self selector
editor_pane = driver.find_element(:tag_name, 'editor-pane')
editor_pane.find_element(:css, '.:displayed')

1 tabbed_pane = driver.find_element(:css, 'tabbed-pane[tabCount = 3]')

1
2

tabbed_pane = driver.find_element(:css, 'tabbed-pane')
tabbed_pane.find_element(:css, '.::selected-tab')

1
2

table_header = driver.find_element(:tag_name, 'table-header')
table_header.find_element(:css, '.::nth-item(3)')

1 table = driver.find_element(:css, 'table[rowCount = 30]')

1 table = driver.find_element(:css, 'table')



JTree

Using [attribute value]

Using : Available pseudoelements are nth-node(index), all-nodes and root.

Getting attributes

People o!en wish to text from a component. This returns a string value.

You can use above code in marathon test scripts to get button’s text.

The web driver instance is available as driver within the script. You can access Java

Component’s attribute using webdriver’s attribute method.

For example: If you want to get row count from JTable

Webdriver’s attribute method always return String.

2
3
4
5
6
7
8
9

# To get particular cell.
mnth_cell = table.find_element(:css, '.::mnth-cell(2, 3)')
# To get all the cells
all_cells = table.find_elements(:css, '.::all-cells')
# To get the cell editor
editor = table.find_element(:css, '.::mnth-cell-editor(2, 3)')
# Marathon equivalent to edit table cell.
select("table", "KnittingModified", "{2, Sport}")

1 tree = driver.find_element(:css, 'tree[rowCount = 10]')

1
2
3
4
5
6
7
8
9
10
11
12
13

tree = driver.find_element(:css, 'tree')
# To get particular node.
nth_node = tree.find_element(:css, '.::nth-node(2)')
# To get all the nodes
all_nodes = tree.find_elements(:css, '.::all-nodes')
# To get the root
root = tree.find_element(:css, '.::root')
# To get the editor
nth_node = tree.find_element(:css, '.::nth-node(2)')
# Th get the editor
editor = nth_node.find_element(:css, '.::editor')
# Marathon equivalet call to edit a tree node.
select("tree_0", "CruiseControl", "/Music/Rock/Harvin Garvel/Persia/Cruise")

1
2
3
4

buttons = driver.find_elements :css, 'button'
buttons.each { |b|
    puts "Button's text is " + b.text
}

1
2

table = get_component('table_name')
puts "Table's row count is " + table.attribute('rowCount')



4.3.2. Java/FX™ Controls

MarathonITE implements a CSS finder for java appplications. You can use WebDriver’s

find_element(s) call to quickly find a control in the application.

Under this section, we will go through di"erent kind of seletors that are available.

Simple Selectors

Some of the simple selectors are tagname, * (all), . (self).

SELECTOR DESCRIPTION EXAMPLE

tagname Selects an element with the given

tagname. A tagname is computed

by finding the FX superclass of the

Control and converting

CamelCase to camel-case.

ToggleButton -> toggle-button,

TextField -> text-field

*

Universal

Gets all the elements. It retuns list

of elements.

driver.find_elements(:css,

'*')

. Self It returns the same element.
tree_view =

driver.find_element(:css,

'tree_view')

tree_view_1 =

tree_view.find_element(:css,

'.')

tree_view and tree_view_1 are

same.

#id Select a Control with the given

id.

For example: If control has id : (set through

javafx.scene.Node#setId method), you find

control using #id.



Above listed selectors can be used on all controls.

Other Selectors

SELECTOR DESCRIPTION EXAMPLE

[attribute

value]

Find controls with the given

value for the attribute. The

operation can be *= (contains),

/= (regex match), = (equals), ^=

(startswith), $= (endswith).

button[text='Click Me!!'].

This selector finds all the buttons

whose text is equal to ‘Click Me!!’

:: Find controls for which returns

true. Pseudoclasses avaiable are

selected, disable,

visible and instance-

of('').

text-field:enabled. This

selector finds all the text-fields

which are enabled.

::

PseudoElements:

This selector finds the pseudo

elements.

driver.find_elements(:css,

'combo-box::all-options')

Operations on controls

Below is the list of controls and the selectors that can be used for it, with examples

Button

Using [attribute value]

Using

ComboBox

1 button = driver.find_element(:css, 'button[text = 'Click Me!!']')

1
2
3
4

button = driver.find_element(:css, 'button:enabled')
# OR using self selector
button = driver.find_element(:css, 'button')
button.find_element(:css, '.:enabled')



Using [attribute value]

Using

Using : Available pseudoelements are nth-option(index) and all-options.

ListView

Using [attribute value]

ruby

list_view = driver.find_element(:css, 'list-view[id ^=

'Places']')

Using

Using : Available pseudoelements are nth-item(index), all-items and editor.

TabPane

1 combo_box = driver.find_element(:css, 'combo-box[id ^= 'Place']')

1
2
3
4

combo_box = driver.find_element(:css, 'combo-box:visible')
# OR using self selector
combo_box = driver.find_element(:css, 'combo-box')
combo_box.find_element(:css, '.:visible')

1
2
3
4
5
6
7
8

# Returns 2nd option from the combo-box
driver.find_element(:css, 'combo-box::nth-option(2)')
# OR
combo_box = driver.find_element(:tag_name, 'combo-box')
combo_box.find_element(:css, '.::nth-option(2)')
 
#Returns list of all the options from the combo-box
driver.find_elements(:css, 'combo-box::all-options')

1
2
3
4

list_view = driver.find_element(:css, 'list-view:displayed')
# OR using self selector
list_view = driver.find_element(:css, 'list-view')
list_view.find_element(:css, '.:displayed')

1
2
3
4
5
6
7
8
9
10
11

# Returns 4th item from the list-view
nth_item = driver.find_element(:css, 'list-view::nth-item(4)')
# OR
list_view = driver.find_element(:tag_name, 'list-view')
nth_item = list_view.find_element(:css, '.::nth-item(4)')
# Get list-view cell editor
nth_item.find_element(:css, '.::editor')
# Marathon equivalent to edit list-view.
select('list-view_0', 'Row 9 Modified', 'Row 9')
# Returns list of all the options from the combo-box
driver.find_elements(:css, 'list-view::all-items')



Using [attribute value]

Using : Available pseudoelements are nth-tab(index) and all-tabs.

TableView

Using [attribute value]

Using : Available pseudoelements are mnth-cell(row, column), all-cells and

editor.

TreeView

Using [attribute value]

Using : Available pseudoelements are nth-node(index), all-nodes and root.

TreeTableView

Using [attribute value]

1 tabbed_pane = driver.find_element(:css, 'tab-pane[id = tab-pane]')

1
2

tab_pane = driver.find_element(:css. 'tabbed-pane')
tab_pane.find_element(:css, '.::nth-tab')

1 table = driver.find_element(:css, 'table-view[id = Employees]')

1
2
3
4
5
6
7
8
9

table_view = driver.find_element(:css, 'table-view')
# To get particular cell.
mnth_cell = table_view.find_element(:css, '.::mnth-cell(2, 3)')
# To get all the cells
all_cells = table_view.find_elements(:css, '.::all-cells')
# To get the cell editor
editor = table_view.find_element(:css, '.::mnth-cell-editor(2, 3)')
# Marathon equivalent to edit table cell.
select('table-view_0', 'Brown', '{'cell':[3,'Last']}')

1 tree_view = driver.find_element(:css, 'tree-view[expandedItemCount = 10]')

1
2
3
4
5
6
7
8
9
10
11
12
13

tree_view = driver.find_element(:css, 'tree-view')
# To get particular node.
nth_node = tree_view.find_element(:css, '.::nth-node(2)')
# To get all the nodes
all_nodes = tree_view.find_elements(:css, '.::all-nodes')
# To get the root
root = tree_view.find_element(:css, '.::root')
# To get the editor
nth_node = tree_view.find_element(:css, '.::nth-node(2)')
# Th get the editor
editor = nth_node.find_element(:css, '.::editor')
# Marathon equivalet call to edit a tree node.
click('tree-view_0', 'Child Node 3 Modified', '/Root node/Child Node 3')



Using : Available pseudoelements are mnth-cell(row, column) and all-cells.

Getting Attribute

You can get text from a control. This returns a string value.

You can use above code in marathon test scripts to get button’s text.

The web driver instance is available as driver within the script. You can access Java/FX

Control’s attribute using webdriver’s attribute method.

For example: If you want to get tab count from TabPane

Webdriver’s attribute method always return String.

Copyright 2019 - Jalian Systems Pvt. Ltd.

1 tree_table_view = driver.find_element(:css, 'tree-table-view[expandedItemCount = 10]'

1
2
3
4
5
6
7
8
9

tree_table_view = driver.find_element(:css, 'tree-table-view')
# To get particular cell.
mnth_cell = tree_table_view.find_element(:css, '.::mnth-cell(3, 4)')
# To get all the cells
all_nodes = tree_table_view.find_elements(:css, '.::all-cells')
# Th get the editor
editor = mnth_cell.find_element(:css, '.::editor')
# Marathon equivalet call to edit a tree table cell.
select('tree-table-view_0', 'Anna Black Modified', '{'cell':['/Sales Department/Anna 

1
2
3
4

buttons = driver.find_elements :css, 'button'
buttons.each { |b|
    puts 'Button's text is ' + b.text
}

1
2

tabPane = get_component('tab_pane_name')
puts 'Tab pane contains ' + tabPane.attribute('tabs.size') + ' no. of tabs.';


